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[ IMPORTANT |

IMPORTANT

Do not apply a strong force while connecting a loader plug. Doing so might damage the instrument.

-

m Handling Precautions

* Application of excessive force to the loader plug might cause communication failure. If such
failure happens, reconnect the plug correctly.

NOTICE

Be sure that the user receives this manual before the product is used.

Copying or duplicating this user’s manual in part or in whole is forbidden.
The information and specifications in this manual are subject to change
without notice.

Considerable effort has been made to ensure that this manual is free from
inaccuracies and omissions. If you should find an error or omission, please
contact the azbil Group.

In no event is Azbil Corporation liable to anyone for any indirect, special
or consequential damages as a result of using this product.

©2015-2017 Azbil Corporation All Rights Reserved.
The SES™ is trademark of Azbil Corporation in Japan.




Unpacking

Check the following items when unpacking:

1. Check the model number to make sure you received the correct product.

2. Check for any obvious damage.

3. Check the contents of the package against the packing list to make sure that all items are included.

Items included in the SLP-SE7 are shown below. Handle the SLP-SE7 and its accessories with care to prevent
damage or loss of parts. If there is any problem with your order, please contact your dealer immediately.

Name Model No. Q'ty Remarks
SLP-SE7 Installation disk | SLP-SE7J90 1 CD-ROM
USB loader cable 81441177-001 1
User’s Manual CP-UM-5756E 1 This manual

Unpacking

CP-UM-5802JE

Describes the configuration for
the SLP-SE7J90

Software License
Agreement

CP-UM-5603JE

Please read the software license
agreement carefully before
installation.




Safety Precautions

A total of three different manuals are available for the SES70. Read them as necessary for your specific

requirements. If a manual you require is not available, contact the azbil Group or its dealer.

Smart Loader Package SLP-SE7 for Intelligent Earthquake Sensor SES70

Manual No. CP-UM-5756E

This manual.

Included with the SLP-SE7 system disk. Make sure this is read by the personnel in
charge of post-setup configuration and operational monitoring. This is a tool for moni-
toring and configuring the device from a PC. This manual provides detailed instruc-
tions on PC installation, Loader functions, and operating methods.

/

N cauio

SES70 Intelligent Earthquake Sensor
Manual No. CP-SP-1393E

Included with the SES70. Make sure these materials are read by the person
who installs and connects this device as well as the personnel in charge of
hardware design for using this device and maintenance personnel. These ma-
terials provide an overview of the device and explain installation method, wir-
ing, startup preparations, and troubleshooting.

SES70 Intelligent Earthquake Sensor User's Manual For System Design
Manual No. CP-SP-1376E

Make sure these materials are read by personnel who will use this device as
well as the personnel in charge of hardware design for using this device and
maintenance personnel. These materials provide an overview of the device
and explain installation method, wiring, startup preparations, internal opera-
tions, troubleshooting, and detailed hardware specifications.




Organization of This User's Manual

This manual is organized as follows:

Chapter1. BEFORE USE
Be sure to read this chapter before you start using the loader.

An explanation of the required PC environment and an overview of functions
are provided.

Chapter2.  LOADER STARTUP AND SHUTDOWN
Explains Loader environment setup, startup, and shutdown.

Chapter 3. BASIC LOADER OPERATIONS AND FUNCTIONS
Explains the Loader menu structure, basic operations, and an overview of the
functions available through the Loader.

Chapter 4. FUNCTION OPERATIONS
Provides a detailed explanation of Loader functions and operations.

Chapter5. TROUBLESHOOTING
Explains troubleshooting in the event of an error message or error during error
status monitoring.

APPENDIX
Explanation of Terminology
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Conventions Used in This Manual

M In describing the product, this manual uses the icons and conventions listed below.

E] Handling Precautions:

Handling precautions indicate items that the user should pay attention to
when handling this module.

Note: Notes indicate information that might benefit the user.

(1), (2), (3): Numbers within parentheses indicate steps in a sequence or parts of an
explanation.

(& This indicates the item or page that the user is requested to refer to.

(Noise protect): Indicates screen message.

[Displayl: Indicates PC screen menu.

[OK] button, [Graph] tab:  Indicates PC screen button or tab. .

[F2] Setup: Indicates a keyboard function key.

[Enter] key, [Esc] key: Indicates a keyboard key.

[Settings]>[Control Panel]: Indicates to select [Settings] on the PC screen, and then select [Control Panel].

>>: Indicates operation results content displayed on the PC or device, or the
device status after an operation.

vi



Chapter 1. BEFORE USE

1-1 Overview

B Overview

B Main functions

The SLP-SE7 Smart Loader Package for the Intelligent Earthquake Sensor (re-
ferred to as “Loader” below) is a monitoring and configuring tool that runs on a
Windows PC and connects to our earthquake sensors.

This Loader can connect to the SES70A and the SES60A.

To ensure easy use for beginners, this system assigns each function to a function
key that allows you to select from menu options.

This Loader has the following functions.

* Current value monitoring function for SI value, acceleration speed, etc.
* Configure sensitivity output and other settings

* Acceleration waveform collection and monitoring function

* File save function for settings values and waveform

* DO, AO manual output function

* Diagnosis adjustment function

* Offline file content display function

1-1
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1-2 Required Operating Environment

The following system environment is required to use this Loader.

B Hardware

Iltem Description
PC Computer PC/AT compatible machine running a Core2Duo or higher CPU 1 GHz or higher
32 bit (x86) or 64 bit (x64) processor
Memory At least 1 GB memory or at least 2GB (for 64 bit systems)
Recommended: 2 GB or higher
Operating system Japanese language version of Windows 7 Pro (32 bit)/(64 bit),
Windows 8 Pro/Ent (64 bit),
Windows 8.1 Pro/Ent (64 bit) or earlier (referred
to as “Windows” hereafter)
Peripheral | Display 1024x600 resolution or higher, 16 bit color or higher recommended
Devices | ysB port 1 or more USB port
Hard disk drive or SSD | Disk space: At least 100 MG for this software
CD-ROM drive At least one internal drive or an external drive
Pointing device Mouse or equivalent device compatible with Windows

E] Handling Precautions

1-2

* FlexGlid70J is installed when you install this Loader. We cannot guarantee
proper functionality if a different version of FlexGlid is already installed. In
this case, we recommend using a different computer.

Close all other applications prior to launching the Loader. The Loader may

not function properly if other applications are running.

If Windows Power Management is running, a communications timeout may

occur if connected for a long time. In such cases, set Power Management to
OFF (Control Panel > Power Management Settings).

Check [Control Panel]>[Regional Options]>[Numbers]>[Decimal symbol] to

u on

ensure that this is set to” . " (a period). SLP-SE7 will not function properly if
this is set to any other character.

Example

For Windows 7, select [Control Panel]>[Clock, Language, and
Region]>[Regional and Language]>[Formats] tab>[Additional Settings]>
[Decimal symbol].

For Windows 8 and 8.1, select [Control Panel]>[Clock, Language, and
Region]>[Region]>[Formats] tab>[Additional Settings]>[Decimal symbol].
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B Hardware configuration

Loader

Data disk

Send/receive Read/save

\
|

Dedicated cable (included)
or RS-485 communication

Personal Computer

B Connection with the earthquake sensor

@® Connection via loader communication (dedicated USB loader cable)

* This method is for connecting to the PC using the attached dedicated cable
(Part No. 81441177-001). Under normal conditions, use this method for the
connection.

* Connect the dedicated cable to the earthquake sensor loader jack and the PC
USB port.

USB port

—

USB loader cable

Personal Computer
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B Connection via RS-485 communication

¢ This method is for connecting to the PC using a commercial RS-485<>USB
converter.

e Use this method for the connection when there is distance between the earth-
quake sensor and the PC.

RS-485 < USB
converter
(commercially available)

USB port

communication line

Personal Computer

* RS-485<>USB converters for which compatibility has been confirmed are
indicated below. (We have not confirmed operational compatibility for any
other devices.)

® Manufacturer: HuMANDATA LTD.
* Model No: USB-003
e URL: http://www.fa.hdl.co.jp/en/

® Manufacturer: MOXA
* Model No: UPort1130I

e URL: http://www.moxa.com/



Chapter 1. BEFORE USE

1 -3 Installation

The following explains how to install the Loader onto your PC.

m Handling Precautions

* The installation program may not function properly if other applications
are running. Close all other applications before launching the installation
program. Furthermore, the Loader may not function depending on the
combination of other applications, drivers, etc,, installed on your PC. See
the user manual included with your Windows PC for details on Windows
and PC settings.

B Installing the Loader

(1) Place the CD-ROM into the CD-ROM drive of your PC.
>> The installation program will launch automatically and display the fol-
lowing screen.

& User Account Control

@ Do you want to allow the following program from an
“ unknown publisher to make changes to this computer?

Program name:  install.exe
Publisher: Unknown
File origin: Hard drive on this computer

() Show detsils e

Change when these notifications appear

(2) Click [Yes] to display the following window.

8 SLP install e
‘\ﬂ/‘ Before installing the driver, disconnect the USB connector.
& install USB loader cable driver |
== install SLP |
azbil

Please select install program

(3) Click [Install SLP].
>> The installation program will launch automatically and display the fol-

lowing screen.

Welcome!

This program will install SLP-SE7(SES70) loader on
YOUr CoPputer.
Click Next to start install.




Chapter 1. BEFORE USE

(4) Click the [Next (N)>] button.
>> The following software license agreement screen is displayed.

Please read the following software license agreement
carafully.

F‘LEﬁSE READ THE FOLLOWING SOFTWARE LICENSE  »
MENT CAREFULLY BEFORE GONTINUING. |a

INOTE: AZBL OORF‘ORAT]DN (HERENAFTER
REFERRED TO AS "AZBL") IS WILLING TO LICENSE
ITHIS SOFTWARE T( YOU (HEREINAFTER REFERRED

! 'ro AS 11-£ USER’ ) on.v ou THE OONDITDN THAT

e OWTAIPED IN THIS AGHEEA.ENT BV CLH(]NG On
THE “AGREE” BUTTON, THE USEH AGREES TO BE
BOUND BY THE TERMS OF THIS AGREEMENT. IF THE
USER DOES NOT AGREE TO THESE TERMS AZEBL IS
LWLLM TO L'DENSE THE SDFTWARE TO THE
GLICK ON THE
mN T ABREE" BUTTON TO EXlT N SUCH CASE,
PROMPTLY RETURN ANY AND ALL AZBL
MATERIALS, ALONG WITH PROOF OF PAYMENT, TO
AZBLL OR ITS DISTRIBUTOR FROM WHOM
CUSTOMER PURCHASED FOR A FULL REFUND OF
'THE PRICE THE USER PADD. All THE GOST OF

Cancel

(5) Click the [Agree] button.
>> The following installation folder confirmation screen is displayed.

Feldar to irstall

Foldar:

CHSIpSaT

Loailabie: ZTTIE0896 k
Susilsble sfter nstall: ZTT223307 k

Note

* (You cannot change the installation destination folder.)

(6) Click the [Next (N)>] button.
>> The following screen is displayed.

Ready to Install. Start to install of
SLP-SE7(SEST0) koader.

Ready to install for SLP-SE7(SES70) loader.

Cancel

1-6
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(7) Click the [Next (N)>] button.
>> The following screen is displayed.

hake short—cut of this loader on desktop. I
this short—cut iz only for this uger, then check
‘Only thiz user’. If thiz short—cut is for all
users, then check “All uzers’

Al users

Ok I Cancel

(8) Select one of the choices, and click the [OK] button.
>> The following screen is displayed.

Installation Completed!

The installation of SLP-SE7(SES70) has been
successtully completed.

Press the Finish button to exit this installation.

(9) Click the [Finish] button.
>> This completes the Installation.

Note

¢ If Adobe Reader is not installed on your PC, download the software from
the Adobe Systems website.
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B Connecting using the USB loader cable

@® How to install the device driver

A device driver must be installed before using the USB loader cable. Follow the
procedure below to install the device driver.

m Handling Precautions

* Make sure you follow the procedure detailed below to install the device
driver. The USB cable may not be recognized if the procedure is not fol-
lowed. If the driver is not recognized, uninstall the device driver and then
redo the installation procedure.

* Administrator privileges are required to install the device driver. This proce-
dure should be conducted by an Administrator or by a user assigned to an
Administrators Group.

* The USB loader cable is compatible with
Windows 7 (32 bit)/7 (64 bit)/8 (64 bit)/8.1 (64 bit).

e |f the PC has multiple USB ports, make sure to insert the USB loader cable
into the same port each time. Inserting the cable into a different port may
require that you reinstall the device driver.

1. Place the SLP CD-ROM into the CD-ROM drive of your PC.

>> The installation program will launch automatically and display the follow-

ing screen.
b SLP install o[ ]
‘P/‘ Before installing the driver, disconnect the USB connector.
=4 install USB loader cable driver |
install SLP |
o
azbil

Please select install program

(1) Click [Install USB loader cable driver]. At this point, do not connect the
USB loader cable to the PC.
>> The following screen is displayed.

| Azbil USE Loader Cable

Welcome to the USB Loader Cable
Driver Installer!

This wizard will wakk you through updating the divers for
your Yamatake USE device.

To continue. dlick Next

1-8
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(2) Click [Next].
>> The following screen is displayed.

Azbil USE Loader

To continue, accept the following license agreemert. To read the ertire
= agreement, Lss the scroll bar or press the Page Dovn key. i

End User License Agreement

I PLEASE READ THE FOLLOWING SOFTWARE LICENSE -
AGREEMENT CAREFULLY BEFORE CONTINUING.

NOTE: AZBIL CORPORATION (HEREINAFTER REFERRED TO AS
"AZBIL") 1S WILLING TO LICENSE THIS SOFTWARE TO YOU
(HEREINAFTER REFERRED TO AS THE "USER") ONLY ON THE
CONDITION THAT THE USER ACCEPTS ALL OF THE TERMS
CONTAINED IN THIS AGREEMENT. BY CLICKING ON THE

h "AGREE" BUTTON. THE USER AGREES TO BE BOUND BY THE -

B

<Back | Ned> | [ Cancel

(3) Select [Agree] and click [Next].

(4) Click [Install this driver software].

>> The device driver installation is launched. Once completed, the follow-
ing screen is displayed.

Congratulations!

The drivers were successfully installed on this computer.

You can now connect your device to this computer. ff your device
Game with instructions. please read them first

Diiver Name Status
 Prolfic (SerZpl64) Ports .. Readytouse |

< Back Cancel

(5) Click [Finish] to complete the installation.

1-9
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2. Connect the USB loader cable to the USB port.

1)

3)

4)

(5)

Once Windows recognizes the USB loader cable, the following type of
indicator is displayed in the task tray and the driver installation wizard is
displayed.

i) Found New Hardware |*
USB-Serial Controller

The following type of indicator is displayed in the task tray once installa-

tion is complete.

d) Found New Hardware =

Your new hardware is installed and ready to use.

==l @ 2:22PM

Launch the SLP-SE7. Since communications have not yet been established,
the system first launches in offline mode. (For details on how to launch in
offline mode, £ M Loader startup (offline startup) (P. 2-2).)

Open the [File]>[Communications Settings] screen and select the
[Connect via USB loader cable] radio button.

Communication Setti

@ Loader cable connection GOM port Mo, - & Loader cable auto-selection

(7) B5-485 connection GOM port Mo

Advanced ssttings B Station address 1=

R X o

Next, click the [Auto-select USB loader cable] button. The number of
the COM port to which the USB loader cable is connected is selected
automatically.

Click the [OK] button to complete the change.
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Note

¢ Clicking the [Auto-select USB loader cable] will cause the port to be se-
lected automatically but, depending on conditions, in some cases the port
is not selected automatically. In such cases, click the [Device Manager]
button to confirm that the port number for Yamatake USB Loader
Comm. is displayed under [Ports (COM and LPT)] then select that port.

£, Device Manager

File  Action  Wiew Help
- = S 2

JAL. 17

Computer

Disk drives

§ Display adapters

L4, DVDJCD-ROM drives

=5 Floppy disk controllers

& Floppy disk drives

i) IDE ATAIATAPT controllers

s Keyboards

D Mice and other pointing devices
B8 Network adaprers

@ Other devices

- 5 Ports (COM & LPT)

! (y‘ Communications Port (COM1)
F\y‘ Communications Part (COMZ)
& Prirker Port (LPTL)

# Yamatake USE Loader Comm. Port (COMS)
E Sound, video and game controllers

System devices

- Universal Serial Bus controllers

(6) The following window is displayed. Click [OK] to enable the communica-
tions settings. Then exit the SLP-SE7 and reboot. The communications
connection is made after reboot.

-
[B® Intelligent Earthquake m u

(i The changes were saved.
To make them effective, restart the loader,
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Bl Connecting via RS-485 Communication

This method is for connecting to the PC using a commercial RS-485—USB

converter*.

(1

2)

Install the driver for the RS-485«<>USB converter. Refer to the user manual
included with the converter for installation instructions.

Connect the RS-485—USB converter to the earthquake sensor and the
PC. Since communications have not yet been established, the SLP-SE7 first
launches in offline mode.

Open the [File]>[Communications Settings] screen and select the
[Connect via RS-485] radio button. Open the device manager to confirm
the COM port number for the RS-485<USB converter. At the bottom of
the screen, select the COM port number (N) and device address, and then
click [OK].

@ Loader cable cornection GOM port No = & Loader cable auto-selection
) GOy
() R5-486 connection COM port Mo l —vf

Advanced settings P Station address 1

B Device manager « ok K Cancel

The following window is displayed. Click [OK] to enable the communica-
tions settings. Then exit the SLP-SE7 and reboot. The communications

connection is made after reboot.

The changes were saved.
To make them effective. restart the loader.

* Refer to “1-2 Required Operating Environment” for details on RS-485«>USB con-
verters for which compatibility has been confirmed.
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1-4 How to Uninstall

B How to uninstall SLP-SE7

E] Handling Precautions

* Make sure to reboot your PC after completing the uninstall. Make sure to
close all other programs prior to conducting the uninstall procedure.

* Administrator privileges are required to uninstall the device driver. This
procedure should be conducted by an Administrator or by a user assigned
to an Administrators Group.

(1)  Select [Control Panel]>[Programs and Functions]. Select SLP-SE7 (SES70)
from the program list and select [Uninstall or Change]. The following win-
dow is displayed.

Select Uninstall Method

Wieloome ta the SLP-SE7SES 70) Smart Loader Packags
uninstal program

You can chooss to automatically uninstall this software or to
chanse sxactly which changes are made ta your system.
Select the Custom buiten to select which modifications are to
be made duting the unirstall Select the Automatic buttan for
the default uninstal options. Press the Next button to continue

@ Automatic
€ Custom

< Back

Cancel |

(2) Select [Automatic uninstall] and click [Next].

(3) Select [Uninstall]. The uninstallation will be completed after a few
moments.

E] Handling Precautions

¢ Uninstalling deletes the content of the SLPSE7 folder on the C: drive but
the actual SLPSE7 folder is not deleted. Manually delete the folder if
necessary.

* A [FlexGrid70J] folder is created on the C: drive during SLP-SE7 installa-
tion but this folder is not deleted during the uninstallation of SLP-SE7.
Manually delete the folder if it is no longer necessary.

¢ Uninstalling SLP-SE7 does not delete any SLP-SE7 data saved in the user's
My Documents folder. Manually delete this data if it is no longer necessary.
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H How to uninstall the USB loader cable driver

[z] Handling Precautions

* Make sure to reboot your PC after completing the uninstall. Make sure to
close all other programs prior to conducting the uninstall procedure.

* Administrator privileges are required to uninstall the device driver. This
procedure should be conducted by an Administrator or by a user assigned
to an Administrators Group.

(1) For Windows 7 (32 bit), select [Control Panel]>[Programs and Functions
- Windows Driver Package Yamatake (YCspl) USB (04/10/2008 2.2.8)] and
click the [Uninstall or Change] button.

For Windows 7 (64 bit), Windows 8 (64 bit), or Windows 8.1 (64 bit),
select [Control Panel]>[Programs and Functions - Windows Driver
Package Prolific (Ser2pl64) Ports (11/19/20092.0.13.130)] and click the
[Uninstall or Delete] button.

Uninstall Driver Package

\_?/ All dervices using this driver will be removed. Do you wish bo continue?

(2) Click the [Yes] button.
(3) Reboot your PC.

B How to uninstall the RS-485«<>USB converter driver

e Refer to the user manual included with the converter for uninstallation
instructions.



Chapter 2. LOADER STARTUP AND SHUTDOWN
2-1 LoaderStartup

Close all other applications prior to launching the Loader. The Loader may not function properly if other ap-
plications are running.

Bl Environment setup

Check [Control Panel]>[Regional Options]>[Numbers]>[Decimal symbol] to

ensure that this is set to “. ” (a period). (Normally, this is already set to period.)

For details, 5 1-2 Required Operating Environment (P. 1-2).

B Connecting the earthquake sensor to the PC

Connect the earthquake sensor and PC via the dedicated USB loader cable. You
also can use a commercially available RS-485«<>USB converter and connect via
RS-485 communication.

You do not need to connect the earthquake sensor with the PC if you only want
to view files (offline). To startup the device in offline mode, remove the commu-
nications cable from the PC.

Removing the cable while online or any other communication failure will re-
sult in the following message: “A connection timeout error occurred with the
earthquake sensor. Exiting program.” The system will then return to Windows.
Reestablish the connection and restart the loader.

The Loader will detect the device type (SES70, SES60) automatically when the
device is connected to the PC. The Loader display and available operations will
reflect the detected device.

2-1
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LOADER STARTUP AND SHUTDOWN

B Loader startup (online startup)

With the earthquake sensor connected to the PC, double-click the
SLPSE7 (SES70) icon on the PC desktop.

Or, click the [Start] button at the bottom of the screen and then select
[Programs]>[SLP]>[SLP-SE7 (SES70)]. (Make sure to complete communications
setup before you launch the Loader.)

For details, {23 1-3 Installation “H Connecting using the USB loader cable” or
“H Connecting via RS-485 Communication.”

>> The Loader will startup and the following main menu is displayed. After
normal system startup, “Online” should be indicated in the status view.

Fle View Help

PG Time 2015/03/20 152718
Sous  Wonee e RS~485 Whte Dissbled o

SLP-SE7J90 (for SES70) Version s

E votor | sewo B wevetom [ @ mewaiost |@  Dieross [E wodechnee [ it

SES?0 (SES7D output function) # Connection (COM7)

B Loader startup (offline startup)

With the earthquake sensor not connected to the PC, double-click the
SLPSE7 (SES70) icon on the PC desktop.

Or, click the [Start] button at the bottom of the screen and then select
[Programs]>[SLP]>[SLP-SE7 (SES70)].

>> The following error screen is displayed.

@ Intelligent Earthquake Sensor IR ==

@ Could not establish & connection to the earthquake sensor.
The following are possible causes.

| *The communication settings are not correct
*No earthquake sensor is connected.

The loader will start up offline
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Click the [OK] button to close the error screen. The following [Open File] win-
dow is displayed.

T Fie Open "— T T —— [l |
Folder: [o#Usersiu Documents¥sp¥SipSe T¥data
Mum  File Size Date/Time
3] sample 001 phase 1 S00SE7 1965 KB 2014/03/20 026112
m2 sample 001 S00SE7 1195 KB 2016/01/18 151758
| o8 sample 2 001 SINSE7 1185 KB 2014/12/18 114728
g sample 2 S00SE7 1133 KB 2014/09/26 166632
[l test60_001 500 5E7 182 KB 2014711718 12428
1 test60_002 500 SE7 192 KB 2014711718 W5 142
7 test70 101 S00SET 160 KD 2014711717 111057
[ test70 002 SO0SET 192 KB 2014711718 DbBa4d
Attribute: (SLP SE7 data file (tse7) -] "/ o | X Cancel
Select the settings file]f both a settings flle and a wavetarm file (Frsv) that nas saved at the same fime are available,
he waveform file can be displayed on the waveform memory screen

Select the settings file “sample_001_S00.SE7” and click the [Open] button. After
offline startup, “Offline” should be indicated in the status view.

File View Help I‘

Wofiive M- PG Time  2015/09/20 163611

SLP-SE7J90 (for SEST0) Version # 4

(c) 2014 Azhil Corporation. All Rights Reserved.

B oo B sew  [B weeon [ |z |= |= (@ e
SES70 (SES70 output function) & Offline

2-3
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2 -2 Loader shutdown

To exit the Loader, return to the main menu and select [File]>[Exit]. Or, press
[F8] Exit.

Save File [HTML] PCTime  2015/00/20 163657
el ) Buit-in  2015/13/20 164233

© Present SLP-SE7J90 (for SES70) Version # 4

@ e |B  sew B e [E] |@ Mewion |@ vemcse @ Mesowe [@ En

SES70 (SES10 oot function) s

7 Connection (COM7) _

Click [Yes] when the following screen is displayed. The system will then return
to Windows.

BB Inteligent Ea

The program will be terminated.
OK?

In an mode other than Measurement mode, the following warning screen is
displayed when you attempt to exit the Loader. If the earthquake sensor is not in
Measurement mode, then the basic earthquake sensor functions (SI value calcu-
lation, analog output, control output, waveform recording, etc.) are not available.
Make sure to confirm the earthquake sensor mode before exiting the Loader.

The mode is not measurement mode
Autarnatic wawve recording is disshled.

[res]: Mode will change to measurerment mode and this program will terminate
[MNa]: Program will terminate as is
[Cancel]: The original screen will be redisplayed

‘ Mo ﬁ Cancel |




Chapter 3. BASIC LOADER OPERATIONS AND
FUNCTIONS

This chapter explains the Loader menu structure, basic operations, and an overview of the functions available
through the Loader.

For a detailed explanation of each function, (? Chapter 4. FUNCTION OPERATIONS.

3-1
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3-1

Basic Operations

B Displaying and transitioning between screens

3-2

| —» =

K

The screen is divided into the following areas. The content of display area A will
vary depending on the operating mode.

Other than display area A, these regions are common to all modes.

Display region A: Main screen

Display region B:
Display region C:

Display region D:

Display region E:
Display region F:

File name display

Online/Offline status, function name

Information indicating operating mode (when online)
Maintenance mode phase indicator

Waveform recording indicator

= I Trend

i Ml Weaveform (c) 2014 Azbil Corporation. All Rights Reserved

Display region G: RS-485 communications write status
Display region H: Upper line: PC time
Lower line: Earthquake sensor internal time (only when online)
Display region I: Supplemental menu display
Display region J: Display menu tree
Display region K: Error indicator
Display region L: Main menu display (menu allocated to function key)
Display region M: Connected earthquake sensor information display

Display region N: Connected communications port information display

B C D E F G H

2015/03/29 152718

RS-485 Write Disabled 2015/03/29 163256

0 5T Vake (PV)
1) Synth. Accel. (PV)
1 Cale. AG Accel

i
L— @ e @ se (@ weeen @

@ wersios |1 Dogosis  |@] Mosechwe [@ et

SES70 (SEST0 output function) # Connection (COM7)

f f

M N
Use function keys [F1], [F2], [F3], [F5], [F6], [F7], [F8] to transition between
screens.
The [F4] key is not used.
Use the [F8] key to return to the previous screen.

In addition to function keys, you can use the menu tree displayed in display area
] to transition between screens.



Bl Menu structure

@ Main menu structure

Top

— [F2] Setup

— [F8] Exit

— [F1] Monitor

+—— [F3] Record waveform

— [F5] Manual Out
—— [F6] Adjust diagnosis

Chapter 3. BASIC LOADER OPERATIONS AND FUNCTIONS

There are two types of Loader menus: the main menu displayed in display area L
of the window and the supplemental menu displayed in display area I (Windows
standard menu area).

The main menu structure is as follows.

The main menu is designed so that the user transitions between each mode
(functions) by using the function key or by selecting from the hierarchal menu
in the displayed menu tree.

For example, when Top is displayed for Monitor, pressing the [F1] key will cause
the screen to transition to that item.

You also may use the mouse to click on the menu display area for the function
keys at the bottom of the screen.

This is also displayed if you click on the area displayed as Monitor in the menu
tree displayed at the left of the screen.

[F1] Alarm Detail
——[F2] Trend [F1] Sl Value (PV)

[F2] Synth. Accel. (PV)
[F3] [Calc. Accel.]

[F4] Calc. AC Accel.
[F3] [Incli. Accel.]

[F6] Display

[F8] Return

L——[F8] Return

[F1] Reset setting values]*
—— [F2] [Accel. Filter]*

—— [F3] [Output Selection]*
—— [F3] Save file

—— [F5] Open file

—— [F6] Set sensor date/time
—— [F7] Write settings
L——[F8] Return

— [F1] Rec. Cond.

—— [F2] Display waveform
—— [F3] Display

—— [F4] [SV Record Display]
——[F5] Save file

+—— [F6] Force record

—— [F7] Delete waveform
L——[F8] Return

[F8] Return

—: [F7] Write settings
[F8] Return

—: [F1] Select SV record targets
[F8] Return

— [F3] Start diagnosis
—— [F4] Zero adjustment
— [F7] [Write settings]
——[F8] Return

— [F7] Mode Change*

Functions indicated in [ ] are functions that can be selected during multiple function settings display.

E] Handling Precautions

* Conducting operations marked with” * ”in any mode other than
Measurement mode will result in the transition to Initialize mode. Please
note that the SES60 may produce unstable analog output in Initialize mode.

3-3
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@ Supplementary menu structure

Bl Online and Offline

The supplementary menu structure is as follows.
The supplementary menu is operated using the mouse.
Use the displayed pull-down menu to switch between settings levels.

There is a Basic Setup display and a Full Setup display. The displayed menu
items will vary depending on the display.

File Save screen display in HTML
—E Communication settings

Exit

Supplementary menu

Display —[ Basic Setup
Full Setup
Help SLP-SE7 Smart Loader Package User Manual PDF

SES70 Intelligent Earthquake Sensor User Manual
(For Design) PDF

Version

The operations displayed in each window of this Loader will vary depending
whether the PC is connected to the earthquake sensor via a dedicated cable (on-
line) or not connected to the earthquake sensor (offline). Some operations are
only available when the system is online.

When online, the current mode of the earthquake sensor is displayed in dis-
play area D. The earthquake sensor has four modes: Initialize, Maintenance,
Measurement, and Standby.

When offline, you can confirm previously saved files containing settings values
and waveform data.

[I] Handling Precautions

* The operation mode is displayed only when the system is online.
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@® About online standby mode

Changing settings, deleting waveform records, etc., requires that the system be
in Standby mode.

However, settings data monitoring can be conducted in any mode.

When you operate the Loader and a screen transition is required, a confirmation
message is shown asking if you want to transition to Standby mode. Follow the
instructions indicated in the message.

The following functions are available in Standby mode.

Menu Operation

Monitor « Confirm current values

Setup * Setup
* Save settings file

Record waveform | ¢ Save and delete record data

» Change waveform recording conditions
Save file * Save file

Manual output * Manual output

Adjust diagnosis * Pickup diagnosis

* Acceleration zero adjustment

E] Handling Precautions

B Function

* The automatic waveform recording function is not available in Initialize
mode, Maintenance mode, or Standby mode.

This Loader provides the following 6 types of functions.
* Monitor

* Setup

* Record waveform

* Manual output

* Adjust diagnosis

* Mode change

An overview for each function is explained in the following pages.
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3 -2 Monitor

The Monitor displays the status of the current earthquake sensor operation.

In the main menu, press [F1] Monitor. Or, select [Top]>[Monitor] from the displayed menu tree.

Error information is continuously monitored. In the event of an error, the information is displayed in display

area K* regardless of which screen is being displayed.

* 2 3-1 Basic Operations (P. 3-2) for information on the display
> Chapter 5 Troubleshooting for a list of error messages.

B Monitoring Screen

area.

This screen displays the earthquake sensor operating mode and measurement

results, calculation results, and outp

ut status.

3-6

- " Time 2016/08/20 15:41:30
Status. [ Online [ Measure RS-485 Wtite Disabled :ih_.“ 201/03/20 154706
Ttem Vakue/Status
Sensor Clock. 2015/06/20 154707
Operating Mode Messure
Maintanance Phase TS
Alarm OFF
Write RS-485 Data impossble (Loader Jack in Use)
S1 Value (PV) 0.0 kine. (sn)
Synth, accel, (FV) 08 Gal (Gontrol Accel. 3 Axk)
IMVEV. (PV) 00
Gale. AG Accel. ZAds: -02 Gal YAxs: 01 Gal XAds: 04 Gal
Gtrl, AG Accel. ZAds: 01 Gal YAds: -05 Gal XAds: -0 Gal
D0/Cantrol Output Selection SES70 output function
D01 Qutput OFF
Minar Failure Outp Chaice (D01) Negative logic  Status/Minor faihure
002 Output. OFF
|Serious Fall. Qutp Gholce (002) Negative locic
008 Output OFF
Noise Outp Ghoioe (D03) Negative logic
Gentrol Output 1 ) OFF
Gentrol Output 2 OFF
Gontrol Output 3 OFF
004 Qutput oFF
AD1 Output Synth, Accel. (PV) Control 3Axis 00 Gal 00 &
AO2 Qutput B Siveke (PV) SN 00 kine 00 %
Version Melor 5 Minor 1
[@ womooi |B 7= [0 @ = |B = [ o
SES70 (SESTO output function) # Connection (COM7)
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B Trend display

SI value (PV value), synthetic acceleration (PV value), calculation acceleration®,
calculation AC acceleration, and calculation inclination acceleration* can be dis-
played as a trend graph. (* is only for Full Setup Display)

Click [F2] Trend. Each trend is displayed after clicking the button. Here, sam-
pling takes approximately 1 second. This creates a buffer containing approxi-
mately 500 seconds of data, allowing you to view past trends. Sampling stops

once the buffer becomes full. Return to the main menu and click [F2] Trend
under [F2] Monitor to clear the buffer and start sampling.

e - " PG Time 2015/08/20 154307
Stawe  [Onine [ Measure 10 Recording Waveform RS-405 Write Dicabled AL okl )
‘}‘Tmm- 100
=i Alsrm o0
re 0
La = | | | | | % Axis
-l Trend ¥ Axis
0 Sl Vae (PY) 0 t T — 2 Axis
I g Synth, Aceel (PV) s0 . ! !
o a0
-l Setup
5 i Wevetorm 301
0 Wawaform List 20
LT Rec. Gond. = 10
. Manual o :
) Disgnasis
-10
20 !
304 :
-40 i
-50
-60
=70 |
.20
=1
-100 -
50 100 150 200 250 300 350 400 450 500
Time (5)
TmeScale 04 50014 Anpl Scale  ~1001% LS [ e ]
H siveie? | Bsmh accel (b 7] | M ook a0 Accel. | 51 |m o  |@ @ eun
SES70 (SEST0 output function) # Connection (COM?)
e
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Bl Error Details Window

3-8

Display error details by clicking [F1] Alarm Detail.

You also can select [Top]>[Alarm]>[Status] in the displayed menu tree to display
error details.

PG Time 2015/00/20 154433

Suus  WOnie  [Mestus I Recording Wevelorm e e Built-in  2015/03/20 155015

§

SEEEEREEEE BEERE

Click [F1] Alarm Detail in the previous screen to switch between the error infor-
mation display and the current error information display for the error informa-
tion latched on the earthquake sensor.

You also can select [Top]>[Alarm]>[Latch] in the displayed menu tree to display
the error information latched on the earthquake sensor.

PG Tms 201503720 154500
Builon 201808720 185097

§

33335335&33335&;

Hlarm Detd Trend |z |= |m |@ |
SESI0 (S50 oyt krctie) # Connaction (COM7)
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3-3 Setup

Allows you to configure earthquake sensor control output settings, time, AO scaling, device address, etc. Press
[F2] Setup in the main menu. You also can select [Top Setup]>[Setup] in the displayed menu tree.

Press [F4] Save File to save the settings.

Press [F5] Open File to display saved settings on the PC Loader.

E] Handling Precautions

* The automatic waveform recording function is paused if Standby mode is
selected when switching to the Setup window.

e [F4] Save File is not available when the system is offline.

* To prevent unintended operations, [F5] Open File cannot write the settings
data saved in the file to the earthquake sensor. This only displays the con-
tents of the saved file.

The settings content window is shown below.

B Setup window

T 1! 154624

Stats [l Onine Stondby Ve e ot 33.%’53 Jsszor

Ttem Value/Status Unit =

SIType E]

Symth. Accel. Tyve Gontrol Accel.

[Syrith. Galc. Accel. Axks |2 e

Synth, Otrl. Accal. Axis 3 s

JVD.1 Gondition OR 1 Vol (PV)

V.1 Gondition AND oFF

JVD.1 Sl Threshald 100 kine L

[ JVD.1 Synth. Accel Threshold .m Gal

JVD.1 MVEV. Threshald 79

1VD.2 Gondition OR S1value (V)

V0.2 Gondition AND oFF

4V D2 Sl Threshakd & kine

| JV D2 Synth.Accel. Threshold .m Gal

JVD2MVEV, Threshald 19

JV/D 3 Gondition OR S1value (V)

[4V/D 3 Gondition AND oFF

4V D3 Sl Threshakd 1 kine

| JV D 3 Synth. Accel. Threshold .‘000 Gal

LUVD3 MVEV, Threshold 79

A0 Output Hold Time 20 s

SIAOSpn 200 kine

Synth, Accel. AD Span 2000 Gal

MVEV. AO Span |0 £
1] = ] | Flesse |E  Fecpen [B] setchex | Wit Sevies [E] e

Setting range:[5 ~ 10] SES70 (SEST0 cutput function) # Connection (COM7)
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3-4 Record Waveform

Displays the 10 waveforms recorded in the earthquake sensor and one forced waveform.
You also can save displayed waveforms onto the PC.

Press [F3] Record Waveform in the main menu. You also can select [Top]>[Record Waveform]>[List of Waveforms]
in the displayed menu tree.

The waveform can be displayed as a graph or as a numeric representation.

[B Handling Precautions

* The automatic waveform recording function is paused if Standby mode
is selected when switching to the Setup window or the Record Waveform
window.

¢ Change Recording Conditions, Force Record, Delete Waveform are avail-

able only in standby mode.

B List of Recorded Waveforms window

Align the cursor with the number of the waveform graph you want to display
and press [Enter] to go to the waveform graph display window.

You also can got to the waveform graph display window by using the left mouse
button to double-click on the row of the waveform number for the waveform

graph you want to display.

PG Time 2015/08/20 154652

Swts [ Olee Stency S B SR Bul-n  2015/03/20 155229

Wave Record Page_ Trigeer Time S |Accel MVEV. |Alrm Uiquef, | VD
Pace 0

Page 1 2015/03/19 164356 13 683 28
Page 2 2015/08/19 171826 11 441 27
Pote 3 2015/03/20 083212 11 3 28
Page 4 Dissble

Pace 5 2015/02/27 124952 ERI:T ] 28
Page 6 2015/02/27 130233 i1 518 27
Pae 7 2015/02/27 149623 13 es0 28
Pace 8 2015/02/27 15:1052 24 1196 34
Page § 2016/08/02 122331 23 178 33
Page 10 2015/08/02 1720:43 11 409 27
Forced Rec Poge  Disable

@ oo @ weeow [@  owe  |@ [@ Fesse [@ Foecdme [@  ocke @ Fen |
SES70 (SEST0 cutput function) # Connection (COM7)
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B Waveform graph display window

Stondoy F5-485 Wite Dizabled

PG Time
Built-in

2015/03/20 154853
2016/03/20 155431

B croph } a Mmt'cvln}?-o B2016/02/27 181652 24 1195 34

-
03

Eh. o ;
LOAAZ Az E
;5255 gigg
fig
i3
2
Gal

151

39 55 71 87 103 119 135 199 215 227 263
Time ()
Time Scale 0% )] Aol Scale  -20003] 20004
M Reccod [ weeDip [B ey | B Fieswe [E] Focedhec |B ot [M  Reun
) N i SES70 (SES70 output function) # Connection (COM7)

Click the [Numeric Value] tab to go to the wave form numeric value window.

B Waveform numeric value display window

z " PCTime  2015/63/20 154811
T _-om: _EE RS- 415 Write Disabled T AliEers
T B Groph ) Humeric vakie [Page B2016/02/27 161052 24 1186 94
| & = Tme 2 YAz X5 -
L] ST AT [} 0.625 ] o
1 2015/02/27 15:10:22.010 0 078 0
2 0 075 0.125
3 125 0878 °
4 ] o7 0
5 0.375 ors °
8 05 0.625 ]
7 0.125 0625 0.125
8 0.125 0525 0.125
s [ o7s o
0 0.375 0.75 0.125
1 .35 075 225
2 0.25 0.75 -0.375
) 0125 075 225
" 0.25 0.625 0.25
15 025 0.5 0.125
% 0.25 0.5 o
7 0.625 0.625 0.125
1. 0.5 0.625 0.125
) [} 0.625 ]
2 .25 o.7s o
2 21502027 15:10:22.210 2.375 075 0.125 -
@ reocod [@ wwos [@ owe |3 |@  Feswe |[@ Foodre |@ ke |@  Reun |
SES70 (SEST0 cutput function) # Connection (COM7)

Click the [Graph] tab to go to the wave form graph display window.
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3 -5 FileOperations

Select Save File from the Setup window in the main menu to save only the settings.
To save the settings and the waveform, select Save File from the Record Waveform window in the main menu.

As when online, after writing to a settings file while offline, the waveform file is displayed via the Record
Waveform window. (However, only when both the settings file and waveform file have been saved.)



3 -6 Manual Output
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You can manually force output when you want to check the earthquake sensor AO, control output, liquefaction

output, or failure output.

Press [F5] Manual Out in the main menu.

B Manual output screen

PCTine 20150320 154349
Statue Ml Online Standy RS-405 Write Dissbled A ML Ao
w—# b_
B | Overoting Mo (rchereesbis] _[Storety
| Preseat Sslect Aute/Morol Atc
| L@ Loten ST Valse (FV) 00 kine.
‘r' AL Synth. fecel (PV) 05 Gal
-ty MVEV. (PV) 00
LETremi | ometew e
| @ Sewp JVD1 (PV) OFF
B -gm“ i JVD2 (FV) OFF
|| [ eestamn ) VD3 FV) OFF
Py A 201 Output 00 %
) Disgnasis A02 Output 00 %
Gontrol Outpet 1 oFF
Gontrol Output 2 OFF
GOt e ) jOEE:
D01 Output Birnk
D02 Output oFF
DOB Output OFF
DO Output OFF
I |® @ [ ! | oot Confimation] [}l Fotam
SES 70 (SES70 cutput function) # Connection (COM7)
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3 -7 Adjust Diagnosis

You can run a diagnosis on the acceleration sensor (pickup).

Adjustment data is configured by default but the inclination adjustment (zero adjustment) can be done at the
Full Setup window.

Press [F6] Diagnosis in the main menu.

B Diagnosis window

2016/03/20 155018 |
201640720 155555 ||

RS-485 Wite Disabled

I SESM (SEST0 output function) # Connection (COM?7)
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3-8 Change Mode

Change the earthquake sensor mode.
Press [F7] Mode Change in the main menu.
A dialog box is displayed.

Change to the desired mode.

B Change mode window

Mode Change l X .'

1 Initialize

@ 2 Measure

(71 & Standby

() & Maintenance

x Cancel

o change the mode to measurement mode, select initialization mode.

. —

E] Handling Precautions
* When you select a function, a mode change confirmation is displayed
during the window transition even if you do not use the Change Mode
function. Follow the instructions indicated in the message. The mode is
changed automatically.

* Note that analog output may be unstable in initialize mode if the SES60 is
connected.

* Analog output is always stable with the SES70.
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4-1

Monitor [F1]

Clicking [F1] Monitor in the main menu will transition the system to the Monitor screen.

[Select Monitor]>[Monitor Display] from the displayed menu tree.

This monitors the current status of the earthquake sensor.

B Displaying the Monitor

Basic Setup

FC Time 2015/03/20 151043
Built-in 2016/08/20 161619

RS-185 Write Disabled

Tten Value/Status

Sensor Clock 2015/03/20 16:16:18

Operating Node leasure

Haintenance Phase =

Alarn OFF

¥rile RE-485 Data Inpossible (Loader Jack in Use)

51 Value (PY) 0.0 kine 1)

Gynth. Accel. (PY) 1.6 Gal (Control Accel. 3 Axis)

M.YV.E.¥. (PY) 0.0

|eale. ac socel 7 kxis: 0.6 Gal ¥ Axis: 0.2 Gal X Axis: -D.4 Gal
Cirl. AC Accel. 7 axis:  -0.5 Gal ¥ Axis: 0.1 Gal X Axis: 0.4 Gal
00/Control Gulput Selection |SEST0 output function

001 Cutput OFF

Minor Failure Qutp Choice (DO1) Nezative logic Status/Minor failure

D02 Output OFF

Sorious Fail- (ute Croice (D02) Mot ive locic

003 Output

Noise Outp Choice (DCG) Negat ive logic

Control Cutput 1 OFF

Control Output 2 |oFF

control Cutput 3 oFF

004 Output OFF

01 Output Synth. Accel. (P¥) Control 3 Axis 0.0 Gal 0.0 %
A2 Outpul SI Value (PY) sn 0.0 kine 0.0 %
Version Major 5 Minor !

I anOesl |[B  Tewd | = @ |@ =] -
] SES70 (SEST output function) # Connection (COM7)
Full Setup
ime  2015/08/20 161100
e st e S e DR Builin  2015/00/20 161636
iTcm Hen Value/Status -
[Moniver | 118
I8y Sensar Clack 2015/03/20 16:16:36
. Operat ing Node Measure
| @ ot Maintenance Phase
& I Trend Alarn OFF
| e SIVM”‘;V) |irlls RS-485 Data Inpossible (Loader Jack in Use)
O S ectl | 151 Value () 0.1 kine 1
€ Cole. AG Aocel synth. Accel. (PV) 1.8 Gal (Control kccel. 3 Axis)
L Gake. bchination Accel. | [M.V.E.N. (PY) 0.1 (Expres!)
8 Seto Calc. AC Accel. T axist 0.2 Gal ¥ Axist 0.0 Gal X Axist 0.3 Gal
& I Woveform
e Tl Calc. Inclination Accel. Z Axis: -14.3 Gal Y Axist  20.2 Gal X Axist 12,5 Gal
1 Pec. Cond. CUri- AC Accel . Z Axist 0.1 Gal ¥ Axis:  -0.4 Gal X Axis: 0.2 Gal =
() SV Record Display Ctrl. Inclination Accel. Z Axis: -14.3 Gal ¥ Axis:  20.2 Gal X Axis:  12.4 Gal
ggﬂ“_ 00/Control Output Selection SEST0 outeul function
o o outeut o
Minor Failure Oute Choice (D01} |Megative logic Status/Minor failurs
002 Outpul
[Serious Fail. Oule Choice (D02) |Negative logic
003 Qutput
Moise Oulp Choice (D03) Negat ive logic
(0FF
Lt il OFF
Control Cutput 3 OFF
004 Output OFF
401 Outpul Synth. Accel. (P¥) Control 3 Axis 0.0 Gal 0.0 %
02 Outpul SI Value (PV) sIl 0.0 kine 0.0 % E
@ Asnvend | Tew @ |m |E @ =] B Fetn
SES70 (SES70 outpul function) # Connection (COM7)
E—

41
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E] Handling Precautions
* The displayed content (items) will vary between Basic Setup and Full Setup.

* For Sl value and other displayed figures, earthquake gauge internal figures
are rounded off to the nearest one-tenth.

* DO1 Output, DO2 Output, and DO3 Output indicate the internal analysis
results. If negative logic is selected, the status may differ from the actual
DO terminal. The following indicates the correlation between the display
and the actual terminal status.

SES70 terminal status
Item Loader display
Positive logic Negative logic
Minor failure OFF OFF ON
ON ON OFF
Blinking Slow OK/OFF Slow OK/OFF
Fast OK/OFF Fast OK/OFF
Flashing Flashing
One of the above One of the above
Serious failure OFF OFF ON
ON ON OFF
Noise protect OFF OFF ON
ON ON OFF
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B Confirming error status

To display the content of an error, press [F1] Alarm Detail. You also can select
[Top]l>[Alarm]>[Status] in the displayed menu tree to display error details.

View this information to respond to any errors that occur.

Press [F8] Return to return to the Monitoring screen.

PG Time. 2015/08/20 16:11:32

Status  WOnine [l Messurs RS-195 Wite Dissbled LT

Value/Slatus

Sensor mewory

Sensor clock H/
Other H/Y
Tenperature (Serious)
Accelerometer
Temperature (Minor)
Batlery level

|40 Converter

Inclination Accel. (Serious)
Accel. Value

Output relay

Accel. noise continuous
Accel. noise

Inclination Accel. (Minor)

Sensor clock data

Note

I Chapter 5. TROUBLESHOOTING (P. 5-1) for information on how to
address.

Press [F1] Alarm Detail again to view the error information latched on the earth-
quake sensor. Press [F1] Alarm Detail to switch between the status display and
the latch display.

You also can select [Top]>[Alarm]>[Latch] in the displayed menu tree to display
the error information latched on the earthquake sensor.

PG Time 2015/03/20 181245
Built-in 2015/03/20 181821

Status: 0 Online 7] Measure I Recording Waveform RS-185 White Disabled

Other H/A
Tenparature (Serious)
Accelerometer
Tenparature (Minor)
Battery level
A/D Converter
Inclination Accel. (Serious)

Serious

Accel . noise
Inclination Accel. (Minor)

522352235535

Fil F3] B
SES10 (SES70 cutput function) # Connection (COM:

i
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B Displaying simple trends

To display the simple trends for each value, click [F2] Simple Trend in the
Monitoring screen. The AC acceleration graph for calculation screen is dis-
played. This trend is displayed as a sampling in approximately 1 s intervals.
(Note that this differs from the sampling cycle of the earthquake sensor.)

. . PG Time 2015/08/20 15:4356
e T Ee-e ===

— X Axis
¥ Axis
— Z Axis.

0 50 100 150 200 250 300 350 a0 450 500
Time (s)

Time Scale 0= 5005 Aol Scale  -100.4) 1004 [ Recaw |
@ sivebe PV | st accel b B Goko Accel. | B Coke G hccel. [B woiaccel [ ey | /@ Feum
SEST0 (SE570 output furction) # Connaction (COM7)

The display targets are assigned to function keys as indicated below. Press the
applicable function key for the trend you want to display. You also can select a
trend from Simple Trend Display under the display menu.

[F1] SI Value (PV)
[F2] Synth. Accel. (PV)
[F3] Calc. Accel.*
[F4] Calc. AC Accel.
[F5] Incli. Accel.*
*is only when in Full Setup Display
@® Making trends easier to view

You can change the display screen (Trends) if the graph display scale is off or if
the X, Y, Z axes overlap making the display difficult to view.
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@® Changing the time interval and amplitude

Use one of the following to change the time axis and amplitude.

(1) Use the mouse to specify the trend display range.

PC Time 2015/08/20 154356
Status '.QI- -&-n I Recording Warveform RS~185 White Disabled Btk btthighiapon
‘TCWDh-‘m g
o i Al 90 t + T T T T T T
) Present 0 ! ! ! I ! I I I
© Lakch pes | | | | ] ] ]
& I Tremd
© Sl Vake (PV) & 1 1 1 1 T T T T
! Synth Accel (PV) s0 ! | i | | 1 | 1
) Cake. Accel P 4 ! L ! 1
--gm.mmu ‘ocel, £ L]
‘,sm 0 ; : o
1 I Wavetorm 10
8 Wovetorm List 3 1 o
|~ Rec. Gond. 1
) SV Record Display 10 1
0 Manual -20
€. Disgrmsis = L] | | 1
Zh D
-50
-0
-7
-80
-90
-100
50 100 150 200 250 300 350 400 450 500
Time (5)
e E e e vE
M sivee (P | [ S ccel | [ Caedcsl. | [ Coo A0 Accal [} bohipccl [ vy | [ |@  Fenm
G (SESNomtfncton 2 Connection (COM7)

Expand the window by dragging the mouse from the upper left to the

lower right.

-  FCTme  2018/08/20 154355
St WOniee [ Measure 1B Recording Weveform W ALANZIT Buitn  20I6/0/20 184832
...
Bl T %0 1 t 1 t t t + +
L Present w0 ! ! ! ! I I I I
2 Latch po | | | | | | |
& I Trond
€ 51 Vakie (P} 8 1 1 1 1 T T T T
[ Synth Rccal (PV) 50 4 4 ! | 1 1 | |
€ Coks. Acoel, 5 | | ! ! I
ot AC accel |
. Gals. Inclination Accal, 30 -
0 Senp 20 1
= I Wartorm = 1o 1
€ Wawetorm List 3
) Ree.Cond. e B |
€1 5V Reoud Display 10 5
! Marual -20
€ Disemsic o 1
e EEE T TR
-50
-60
-7
-0
-90
-100
50 100 15 200 250 300 350 400 450 500
Time (s}
Tinn Scale [ 5002 fmol Scale  -1003 ws| [ Rewe |
M Siveue(P | MBS dccel ()| [ Calc.decsl | [H Coke A Accal [ woiipccel | Disoey | (3 @ hem |
) SES70 (SES70 outout function) # Connection (COM7) _
S —————

Drag from the lower right to the upper left to return the window to the
default size. The drag position is recognized anywhere, regardless of trend
width.

(2) Click the [A]/[V] buttons in the window.

(3) Directly input a numeric value in the window input column.
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(4) Click the column of the window you want to change and then press the
[1T V] Tkeys.

| £ e 5]

0 100 150 200 250 300 %0 a0 as0 $00
Time (8)

| Tmosca [E o ool Scak <100 5 s

M sivein ) | B S Accot (70| ] Coke Accel | (M) GokohO Acoet [ iciAceet [@ 0w | @ |@ e

|_ A: Increase value

Entry column ¥ Lower value

After making the change, click the [Redraw]button. To change display content to
other items, press the [F1] through [F5] keys.

@ Changing the graph display

You can change the number of axis lines displayed if the graph displays of the X,
Y, Z axes for the calculation AC acceleration, etc., overlap making the display
difficult to view.

While displaying a graph, press [F6] Display or right-click on the graph to dis-
play a list of display change options.

2D/3D Display Dimension
Manual fAuto Scale
X Color
¥ Color
Z Color
v | X Hide/Show
¥ | ¥ Hide/Show
v | Z Hide/Show

[2D/3D Display Dimension (3)]: Switch between a flat graph and 3D display.

[Manual/Auto Scale (W)]: Switch between auto and manual adjustment of the
graph width range. After switching to manual, when
you switch back to auto the settings revert to the set-
tings applied prior to switching to manual.

[X-axis color (C)]: Changes the color of the X-axis
[Y-axis color (O)]: Changes the color of the Y-axis
[Z-axis color (L)]: Changes the color of the Z-axis
[X:Hide/Show (X)]: Switch between displaying and hiding the X-axis.
[Y:Hide/Show (Y)]: Switch between displaying and hiding the Y-axis.
[Z:Hide/Show (Z)]: Switch between displaying and hiding the Z-axis.
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Pressing [F2] Setup in the main menu will switch to the Setup screen.

You also can select [Top]>[Setup] in the displayed menu tree.

When switching to the Setup screen, a message will be displayed asking if you want to switch to Standby mode.

@ Switch to Standhy?

[ves]:.Change Screen with Mode fransition

[Mo]:Change Screen with Non Mode fransition
[Cancel]:Cuit

* To change settings, click [Yes] and switch to Standby mode.

¢ To confirm current settings, click [No] to change screens without switching to
Standby mode.

¢ To cancel, click [Cancel]. The system will return to the Top screen.

After changing the settings, press [F7] Write Settings.

FoTme  0I0VN 1R
Suss  [Give Sty 415 Wi Disstied v
L33 Tten Va lue/Status it [~
e ST Towe st
i M Svnth. dccol. Tros cuntrol Accel.
 Lah [Soth. Gale. Accel . hais 2 wis
L] Srnth. GLrl. Aceel. ks 3 it
gt 4401 Conditien O 61 Yalue (%)
2 S Acoe (74
O Cale, W et [J-¥.D.1 Condition AND OFF ¥
) 4.4.0.1 51 Threshold 100 ine
Vi J.9.0.1 Synth. kecel. Threshold 4000 (al
© sk Lt 49D NVEY. Thresbald 7.8
i 4.4.0.2 Condition (K )
. Disenasis 4.¥.0.2 Conditien WD
J.9.0.2 §1 Threstold Kine
J.4.0.2 ynth. kccl . Thrashold am i
[J.V.0.2 W.V.E.¥. Thrashold 7.8
J.¥.0.3 Condition OR 81 Yalue (P¥)
(J.¥.0.3 Condition &ND WF
[J.¥-0.3 51 Thresho|d kine
4.4.0.3 Sunth. hecal . Thrashold mu Gl
4.4.0.3 W.V.E.V. Thrashold
(A0 Cutput Hold Time !II s
81 A0 Sean 200 kine =
1 ([ 53] | fisew | Fecom [M Seices |0 Whesewee W R |
SES70 (SE510 oulut hrcten) # Cormaction (Co7)

PO T 2015/000 111

ot Ban 2015w 142088
Tten Value/Status Unit
51 Tre s
[Srath. Accel. Trom control Accel.
Soth. Gale. Accel . hais 2 wis
Grnth. Curl. Acesl. ks 3 wis
WA.EN. Eprassion £l §1/0al
4.9.0-1 Conditien o 51 ¥alug ()
4.0.0.1 Condition D o
4.9.0.1 51 Threshald 100 Kine
4.4.0.1 Synth. Aecal . Threshold 4100 Gal
44,1 WV.E.¥. Threshold
4.4.0.2 Condition R 51 value (1)
0.4.0.2 Gondition WD CFF
J.9.0.2 61 Threshald kine
4.9.0-2 Synth. kccal - Thrashold m &l
4.0.0.2 N.V.E.¥. Thrashold
4.4.0.3 Condition G i vsis )
4.4.0.3 Conditlon D oFF
4.4.0.3 81 Threshald 10 Kine
4.4.0.3 Synth. ccel. Threshold 4000 o
4.4.0.3 N.V.E.. Thrashold 1.9
40 cuteut Hold Tise n s

[ it | ovoutsooctin | M) riosom [M Fiecom [M] Setces [ whesetees [H  Fesen

:05 ~ 101

SESH (SES10 output hrtiond

E] Handling Precautions

2 Cornaction (COMT)

* The displayed content (items) will vary between Basic Setup and Full Setup.
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B Setting item
The following settings can be changed on the SES70.

@ SlIValues [SES70 only]
Select either SI Value 1 or SI Value 2.
SI value 1: 7 fixed cycles, 8-direction projection
SI value 2: 24 fixed cycles, 16-direction projection
SI Values - Default value: SI Value 1

@ Synthetic acceleration types

For the synthetic AC acceleration PV Value, select between calculation synthetic
AC acceleration and control synthetic AC acceleration.

Synthetic acceleration types - Default value: Control synthetic AC
acceleration

@ Select the number of synthetic acceleration axis lines

For the synthetic axis of both calculation synthetic AC acceleration and control
synthetic AC acceleration, select flat 2-axis (X/Y) or 3-axis.

Calculation - Default value: 2-axis; Control - Default value: 3-axis

@ Select M.V.E.V. formula (Full Setup only)

For the M.V.E.V. formula (formula for the Japan Meteorological Agency seismic
intensity scale value), select either the formula that calculates using both SI
Value and acceleration or the formula that calculates using only SI Value.

Formula 1: uses both SI Value and acceleration
Formula 2: uses SI Value only

M.V.E.V. default formula: formula 1

4-8



@ J.V.D. settings
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You can set three J.V.D. conditions. (J.V.D.1 Condition, ]J.V.D.2 Condition,

J.V.D.3 Condition) [For SES60, only J.V.D.1 Condition is available]

For each J.V.D. Condition, you can select the SI value for turning the Control
Output ON/OFE the synthetic AC acceleration, the M.V.E.V. value, and the logic
calculation for liquefaction judgment value.

You can set the threshold values for the SI value used for control output, the syn-
thetic AC acceleration, and the M.V.E.V.

Item name Setting Default value . Set
increments
J.V.D.1 OR condition The logical sum of the AND condition and OR condition | AND condition: None
J.V.D.1 AND condition are set as the J.V.D. condition. However, both AND/OR OR condition: None
conditions cannot be set for the same field.
AND condition: The AND condition of the setting field
is set as the J.V.D. condition. OR condition: The OR
condition of the setting field is set as the J.V.D. condition.
JV.D.1 SI Threshold 1 to 300 kine 300 1 kine
JV.D.1 Synthetic 5 to 4000 Gal 4000 1 Gal
acceleration threshold
JV.D.1 M.V.E\V. threshold | 1.0t0 7.9 7.9 0.1

*The same also applies for J.V.D.2 and J.V.D.3.

Click the line of the [J.V.D. OR condition] or [J.V.D. AND condition] to set the
J.V.D. condition. The following window is displayed regardless of which one you
click. Set the OR condition and the AND condition. The enabled settings are
those with a highlighted button.

However, both AND/OR conditions cannot be set for the same field.

JVD.Cond.OR |1 SI Vakue (PV) | 2 Synth. ficcel. (PY) | 5 Liguet. Judg. (PY) | I MVEM.(PV) I
JND Gondl AND & Synih. Accel. (FU) | § Liguel. Jude. (P) | ;
[I] Handling Precautions

* The default values for J.V.D. have changed compared to the SES60. Refer
to the following table to see the points of difference. The default setting
for the SES70 is to not conduct J.V.D. so make sure to configure this setting
prior to use.

Default settings for J.V.D. condition (comparison with previous model)

SES50/51/55/60

SES70 (Previous model)

Item

J.V.D. OR condition
J.V.D. AND condition

OR condition: Sl value
AND condition: None

OR condition: None
AND condition: None

J.V.D. SI Threshold 300 kine 30 kine
J.V.D. Synthetic acceleration threshold 4000 Gal 300 Gal
J.V.D. M.V.EV. threshold 7.9 5.3
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@ Output hold time setting

You can set the control output (relay), liquefaction output (DO4), AO1, and

AO2 hold times. (Control output hold time and liquefaction hold time are avail-

able only in Full Setup mode)

Item name Setting Default value | Setincrements
Control Output Hold Time | 20 to 604800 s 20s 1s
D04 Output Hold Time 20 to 604800 s 20s 1s
AO Output Hold Time 20 to 604800 s 20s 1s

@ Select AO span

You can change the span allocation setting of 0 to 100 % (4 to 20 mA) for AO1

and AO2.
Item name Setting Default value | Setincrements
SI AO span Select from 50, 100, 150, and 200 kine/20 mA 200 kine 1 kine
Synth. accel. AO span Select from 500, 1000, 2000, and 3000 Gal/20 mA 2000 Gal 10 Gal
M.V.E.V. AO span Select either 5.0 or 8.0 (20 mA) 8.0 0.1

@ Select AO object

Instead of selecting, you can double-click the item and directly input a span value.

You can select the output object data for AO1 and AO2.

Item name

Setting

Default value

Set increments

Select AO1 object

Select from Synth. Accel. (PV), SI (PV), or M.V.E.V. (PV)

Synth. Accel. (PV)

Select AO 2 object

Select from Synth. Accel. (PV), SI (PV), or M.V.E.V. (PV)

Sl value (PV)

@ AO ratio setting (Full Setup only)

You can select the output ratio for AO1 and AO2.

Item name Setting Default value | Setincrements
AO1 ratio 0.900 to 1.100 1.000 0.001
AO2 ratio 0.900 to 1.100 1.000 0.001

@ AO bias setting (Full Setup only)
You can select the bias setting for AO1 and AO2.

Item name Setting Default value | Setincrements
AO1 bias setting —5.0to +5.0% 0.0% 0.1%
AO2 bias setting —5.0 to +5.0% 0.0% 0.1%

® PV low cut
You can set a low cut setting for the SI PV, Synth. Accel. PV, and M.V.EE.V. PV.

Item name Setting Default value | Setincrements
SIPV low cut 0.0 to 30.0 kine 1.0 kine 0.1 kine
Synth. Accel. PV low cut 0.0 to 400.0 Gal 5.0 Gal 0.1 Gal
M.V.E.V. PV low cut 0.0to 3.0 1.0 0.1

*On the SES60, the default value for all three fields is 0.
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@® PV bias
A calculated bias is reflected in the SI PV, Synth. Accel. PV, and M.V.E.V. PV.
Iltem name Setting Default value | Setincrements
SI PV bias —30.0 to +30.0 kine 0.0 kine 0.1 kine
Synth. Accel. PV bias —400.0 to +400.0 Gal 0.0 Gal 0.1 Gal
M.V.E.V. PV bias -3.0t0+3.0 0.0 0.1

@® N.P.Serious Fail Time

You can set the serious fail time caused by continued noise protect.
Settings range: 5 to 10080 min
Default value: 30 min
Setting increment: 1 min

@ NP lower threshold (only when in Full Setup)

The noise protect function operates based on multiple logics. One of these is a
logic that treats the phenomenon of AC acceleration pulses in the positive or
negative direction as noise. You can set the lower threshold for the AC accelera-
tion at which this logic operates.

Single axis ratio NP lower threshold: 1 to 200 Gal
Default value: 50 Gal
Setting increment: 1 Gal

Another is a logic that treats AC acceleration occurring in both the positive and
negative directions as noise when the acceleration is limited to a single axis (X,
Y, or Z) and there is little movement on the other axes. You can select whether
or not to run this logic. If run, then you also set the lower threshold for the AC
acceleration.

Select other axis ratio NP detection: Use/prohibit
Default value: Use

Other axis ratio Z-axis NP lower threshold: 1 to 200 Gal
Default value: 100 Gal
Setting increment: 1 Gal

Other axis ratio X/Y-axis NP lower threshold: 1 to 200 Gal
Default value: 50 Gal

Setting increment: 1 Gal
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@® Minor Failure Outp Choice (DO1)

You can set Liquef. Minor Failure Outp Choice (DO1) as Status/Minor Failure
(Minor Failure Mode) or Minor Failure only. You also can set the output logic as
positive or negative.

Default value: Status/Minor Failure, Positive Logic

@ Serious Fail. Outp Choice (DO2) [SES70 only]
You also can set the output logic for Serious Fail. Outp Choice (DO2) as positive

or negative.

Default value: Positive Logic

@® Noise Outp Choice (DO3) [SES70 only]
You can set the output logic for Noise Outp Choice (DO3) as positive or

negative.

Default value: Positive Logic

@® Communication settings

You can set the device address, RS-485 communications data format (parity
check), and RS-485 communications transfer speed. The data format is fixed at
a data length of 8-bit and a stop bit of 1-bit. Only parity (“None” or “Even”) can
be selected.

Item name Setting Default value
Device address 0to 126 1
RS-485 communication data format (parity) Select parity as “None” or “Even” Even
RS-485 communication transfer speed Select from 9600 bps, 19200 bps, or 38400 bps 38400 bps

*With the SES60, both Loader Communication and RS-485 Communication are set. You also can select a transfer speed of
9600 or 19200 bps. (Default value: 19200 bps)

@ Liquefaction detection Enable/Disable (Full Setup only)

You can select to enable or disable liquefaction output.
Default value: Enabled

@ Reset settings (Full Setup only) [SES70 only]

You can press [F1] Reset Settings to reset the device settings to the default
settings.

All settings other than communications settings are returned to their default
values. All recorded waveforms and other data are deleted.

Be careful as once executed, this operation cannot be undone.

Executing this function also sends the device into Initialize mode.
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@ Acceleration filter (Full Setup only)

You can press [F2] Accel. Filter to select the filter value for both Calc. Accel. and

Control Accel. Select from 3, 5, 7, 10, 20, 30, 50, or 100 Hz.

Calc. default value: 30 Hz

Control default value: 10 Hz

)1 100H: & 100H
- EOH: B SO
: 30Hz (Default) ) D 30He
ST ) E 20H:
10He E 10Hz (Default)
He O G THe
5Hz O H SHe
3Hz O e
T ime
[F]ZGN Seleotion
et Valle s Recommended value 20 Setting range 3 o 630 =

v ] ok | % Cancel |

T his aperation 1@ executed, the mode will chanee (@ nitialization mode:
If an unlisted value i set, no settine can be selected from the list.

|

* Changing this setting will affect earthquake sensor operations. Make sure you fully

understand the impact of changing these settings before making any changes.
Executing this function also sends the device into Initialize mode.

@ ZCN Selection (Full Setup only)

You can press [F2] Accel. Filter to select Use/Prohibit for the ZCN detection. If

you select “Use,” you then can set the ZCN time.
Default value: 20 s
Setting increment: 1 s
Executing this function also sends the device into Initialize mode.

Accel. Filter

Galoulation Accel. Filtsr Gontrol Accel. Filter
© 1 100H & 100H
- EOHz B S0H:
: 30z (Default) © D 30H:
: 20H: ) B 20H:
10Hz ) E 10Hz (Default)
He G THe
5He H o SHe
O & e b3k
ZGN time
[F1ZGN Seleotion
Set Valle s Recommended value 20 Setting ranee 3 o 630 s

7 oF | % gencel |

If this operation is executed, the mode will chanee to initialization mode.
If an unlisted value is set, no getting can be selected from the list

!

The recommended value for ZCN time changes in correlation to the Cal. Accel.

Filter value.

Make sure to adjust the ZCN time to the recommended setting.
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@ Output Selection (Full Setup only) [SES70 only]

You can press [F3] Output Selection to select between SES70 Output and SES60
compatible output.

SES60 compatible output makes the following changes to the SES70 output to
output a signal equivalent to the SES60.

Item

SES70 output

SES60 compatible output

J.V.D.

JVD.1,2,3

JV.D. 1 only

Control output

Control output 1,2, 3

Control output 1 only

Minor Failure Outp.*

Status/Minor Failure

Status/Noise/Minor Failure

DO3 Output

ON

None

Maintenance sequence

Phase 1to 3

Phase 1 only

* Status/Minor Failure for the Minor Failure Output function simply switches to the Status/Noise/Minor Failure function.
The selected settings fields are not updated automatically. (For example, fields set to “Minor Failure Only” do not auto-
matically switch to “Status/Minor Failure”) Make sure to change the settings fields as required.

Default value SES70 output

© I SES70 output function

(©) & SES60-compatible output function

(1) If this operation is executed, the mode will change to initialization mode.

Executing this function also sends the device into Initialize mode.

Note: Simply changes the output function selection to “SES60 Compatible” but this does not provide the same
exact operations as the SES60. Also change the following as necessary. (The following is a comparison
with default values. Make the necessary changes if you have changed the default values.)

Item

SES70 output

SES60 compatible output

J.V.D. OR condition

OR condition: None

OR condition: Sl value

J.V.D. AND condition

AND condition: None

AND condition: None

J.V.D. Sl Threshold 300 kine 30 kine

J.V.D. Synth. Accel. Threshold 4000 Gal 300 Gal

J.V.D. M.V.E.V. threshold 7.9 53

Rec.Trigger Threshold Max. Wave (+Trigger Updating)

Max. Wave (+Trigger Updating) object Slvalue Slvalue

Max. Wave (- Trigger Updating) object Sl value - (no function)

Threshold object Slvalue Slvalue

Threshold S| 1 kine 30 kine

Threshold - Synth. Accel. 5 Gal 300 Gal

Threshold - M.V.EV 1.0 5.3

RS-485 communication speed 38400 bps 19200 bps

Minor Failure Outp Choice (DOT) Positive logic value Status/ Positive logic value Status/Minor Failure
Minor Failure (Function operates as Status/Noise/Minor Failure)

Serious Fail. Outp Choice (DO2) Positive logic Positive logic

SI PV low cut 1.0 kine 0.0 kine

Synth. Accel. PV low cut 5.0 Gal 0.0 Gal

M.V.E.V. PV low cut 1.0 0.0
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Bl How to change settings

@® How to input settings

To change settings values, align the cursor (blue inverted character) with the
content in the field you want to change in the Setup window and double-click.

There are three ways to input values as indicated below. the input method varies
with each method.

(1) Select

(2) Numeric input

(3) Select + numeric input

After completing all input, press the [F7] Write Settings button. The changed
values are written to the earthquake sensor memory. After writing settings to the

memory, those values are read and monitored so you can confirm that the cor-
rect values have been written.

Make sure to write the settings to the memory. If you do not perform this mem-
ory write, the settings data will revert to the previous values once you reset the
earthquake sensor or go to the Initialize screen.

(1) Double-click on a selection method, select the field you want to set from
the pull-down, and then press the [Enter] key.

Iten Value/Status Unit
A0 Output Hold Time 20 s
D04 Qulput Hold Time 20 s
Control Qutput Hold 20 3
S1 A0 Span 200 kine
Synth. Accel. AD Span 3000 Gal
M.V.E.¥. A0 Span

401 Select ion

AD2 Select ion

AD1 Ralio Value

A02 Ratio Yalue

AO1 Bias Value

A2 Bias Value

S1 PY Low Cul

Synth. Accel. P¥ LowCut
M.¥.E.¥. PV Low Cut

S1 PV Bias 0.0 kine
Synth. Accel. PV Bias 0.0 Gal i
M.V.E.V. PV Blas 0.0

N.P. Serious Fail Tine 30 Ninutes
SRNP lover linit 50 Gal

ORNP selection Enable -

(2) Numeric input method
Click on the desired field line, input the desired values in half-width char-
acters, and then press the [Enter] key. For reference, you can align the cur-
sor with the value field to display the applicable value range at the bottom
left of the screen. The field column becomes red to indicate an error if a
value exceeding the applicable range is input. Make sure to input an ap-
propriate value.

Iten Value/Status Unit -
Synth. Accel. Type Control Accel -

8ynth. Calc. Accel. Axis 2 axis
Synth. Ctri. Accel. Axis 3 axls
W.V.E.V. Expression Exl: S1/Gal

J.¥.D.1 Condition OR S1 Value (PV) E
J.v.D.1 Condition AND OFF

J.¥.D.1 SI Threshold 100] Jkine |
J.V.D.1 Synth. Accel. Threshold |4000 Gal
J.V.D.1 W.V.E.V. Threshold 7.8

J.¥.D-2 Candition OR 81 Value (PV

J-V.D-2 Condition AND OFF

J.V.D.2 81 Threshold ] kine
J.¥.D.2 Synth. Accel. Threshold |4000 Gal
J.9.D.2 W.V.E.V. Threshold 7.8

J.¥.D.3 Condition OR S1 Value (PV)

J.¥.D.3 Condition AND OFF

J.¥.0.3 81 Threshold 10 kine
J.V.D.3 Svnth. Accel. Threshold |4000 Gal
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(3) Select + numeric input
Select the field you want to set from the pull-down, and then press the
[Enter] key or input the numeric value and then press the [Enter] key. The
precautions related to numeric value input are the same as the precautions
for (2) Numeric Input.

Tten Value/Status
004 Outpul Hold Time 20

Control Cutput Hold 20 o S
51 40 Span f.00]

Synth. Accel. AO Span 50

W.V.E.V. AO Span I

A01 Selection

A02 Selection sl Value (PY)
401 Ratio Value 1.0000

A0 Rat io Value 1.0000

401 Bias Value 0.0

A2 Bias Value 0.0

S1 PV Low Cut 1.0

Synth. Accel. PV LowCut 5.0

W.V.E.V. PV Low Cul 1.0

51 PV Bias 0.0

E] Handling Precautions
* When inputting a value for the earthquake sensor, after inputting the value

confirm that the appropriate value has been input.

* Inputting the incorrect value can result in performance that varies from
customer expectations.

@ Aligning the internal sensor clock

(1) Press [F6] Sensor Clock Settings to set the internal sensor clock.
>> The settings screen is displayed.

@
.
Set the date for the sensor

@ I Auto setup (same as the PC)

() Z Manual setup (input the desired date )

2015/08/20 18:14:06

X cwcel |

(2) Set one of the following.
>> 1: Auto: Aligned with PC internal clock
2: Manual: The following date and time settings area is displayed and
allows you to manually input the settings.
(3) After inputting settings, click [OK]. To cancel, click [Cancel]. The system

returns to the Setup window.



Chapter 4.

FUNCTION OPERATIONS

@ To save settings

@ To open saved data

(1)

2)

Press [F4] Save File.

>> A file name input dialog box is displayed.

Folder: C¥Userst Jocuments¥s Ip¥SipSe Pédata

Mam  File
001 sample 001 SODSE?
002 samplep? 001 S00SET
o0z sample p2 SI0SET

Size
1195 KB
1186 KB
1133 KB

Date/Time

2015/01/21 175430
2014/12/18 11:47:28
2014/00/26 155932

Filename:

s operation is executed only the sstines file v

e x o

Input the file name and click [Save] or press the [Enter] key.

>> The file is saved.

Note

(1)

¢ Other than the character string specified by the user, the settings file

name is determined automatically.

XXXXXX_VVV_SNN.SE7

XXXXXX: Filename specified by the user

VVV: Version No. (XXXXxX)
S: Meaning of settings file
NN: 00 (fixed)

e If a file with the same name exists, the file is not overwritten. Instead, it is

saved as a new file with a sequential version number.

* The Save File function at the Setup screen only saves the settings file and

does not save the waveform file.

¢ To save the waveform file, conduct the file save process at the Record

Waveform screen.

Press [F5] Open File.
>> The Select File screen is displayed.

002 samplep2 001 S00SET
008 sample p2 SODSET

Folder: [G¥Users¥ Documents¥sip¥SipSeT¥data
Mam File Size Date/Time
oot sampls_001 S005E7 1195 KB 2015/01/21 125430

1185 KB
1133 KB

2014/12/18 1147:28
2014/09/26 165932

Atribute: [SLP SE7 data file (+se7)

e ] X e |

waweform file can be displayed on the waveform memary

lect the settings fileJf both a settings file and a waveform file (*cav) that was saved at the same time are available.
screen.
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(2) Select a file and click [Open].
>> A new window (offline mode) is launched.

Note
* There are multiple settings for the file type (*.SE6 and *.SE7).

* * SE6: Settings file saved using the previous version of the Loader
(SLP-SE®6).

* *.SE7: Settings file saved using this Loader.

e Either file type can be opened. However, only files saved as SES60 can be
opened as *.SE6. (Not compatible with files saved as SES50/51/55.)

* *SE6 and *.SE7 settings files are a proprietary format that can only be
viewed by the customer via the Loader.
@® To read settings data

(1) After inputting all settings, press [F7] Write Settings.
>> A confirmation screen is displayed.

(2) Click[Yes].
>> The settings are written and settings configuration is complete.

m Handling Precautions

* Make sure to write the settings to the memory. If you do not press
[F7] Write Settings, all the settings data except the clock data will revert
to the previous values once you reset the earthquake sensor or go to the
Initialize screen.

@ Setting the earthquake sensor to Measurement mode

Press [F8] Return to return to the Top screen and then press [F7] Mode Change
to switch to Initialize mode. After switching to Initialize mode, the system will
transition to Measurement mode automatically.

* Please note that the SES60 may produce unstable analog output in Initialize
mode.
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4 -3 Record Waveform [F3]

In the main menu, press [F3] Record Waveform to switch to the List of Waveforms screen and display a list of
recorded waveforms.

Or, you also can select [Top]>[Record Waveform]>[List of Waveforms] in the displayed menu tree.

When the earthquake sensor is in Measurement mode and you switch to the List of Waveforms screen, a mes-
sage will be displayed asking if you want to switch to Standby mode.

Switch to Standby?

[ves]:Change Screen with Mode transition
[Ma]:Change Screen with Non kMaode transition

[Cancel]:Cluit
Bt St

* To change waveform recording conditions, click [Yes] and switch to Standby

mode.

¢ To confirm current waveform recording conditions, click [No] to change the
screen without switching to Standby mode.

® To cancel, click [Cancel]. The system will return to the Top screen.

When the earthquake sensor is in Measurement mode, normally calculation accelerations for three axes are
stored in 12 buffers (auto waveform records 0 to 10, forced waveform record).

A single buffer can store a 10 ms sampling for a total of 360 s (36000 data). There also is a buffer for forced
waveform records and while in Standby mode you can confirm whether or not the waveform is being recorded
properly. In Standby mode, press [F6] Force Record to force start waveform recording.

FC Tima 1628 BRALET

Status. W cnine Standty RE-135 Write Dissbled Bl i M

keeel - (M.V.ELV. Rlare Liguef. J.¥.D.
:H'IENS.I’I! 18243256
|amsmang 17:18:56
:HISNSHII 06:32:12
I‘EI'I'Iﬁ.-"ﬂSJ'!S 08:12:0%

B5.3 2.8
6.1 2.8
Inlilhli

:!ms:"ﬂz-’!? 13:02:33 1.1 5.8 2.9
I?ﬂ‘ﬁfﬂ!ﬂ? 18:38:23 1.3 B5.0 2.8
I‘Eﬂlsfﬂzﬂ? 15:10:52 2.4 18.B 3.4
____________ IGEN2 12:75:31 23 118 8.8
2015/03,/02 17:20:43 1.1

Forced fec. Page |Disable

| M fovmdfen |'._ Do | Fetar,

SEST (SE570 culput hanction) # Connection (COM7)

@ Ffecos @ woeow [E by M Vel [@ Fieswe
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B Displaying waveform data as a graph
In the List of Waveforms screen, press [F2] Display Waveform to open a wave-
form display selection screen. Select the number of the waveform you want to
display from the pull-down and click [OK].

You also can go to the waveform graph display window by double-clicking on
the row of the waveform you want to display in the List of Waveforms screen.

At first, the entire waveform is displayed.

FOTame 0160073 0BK26

i ot L) Bk 018m07 ns220
B | 7 Munerks vabe | Page 22016/ 125231 28 103 83
100
50
2
.
e
-0
1 Fec Cord.
2 SV Record Disslay e
1 Mrusl
£ Dizgrosic 27 28 ) 0 a1 a2 E9 31 35
Time (3)
e I

B eced [B wveow [@  oww B strcowh (B fwses B eesree @1 e (@ e

SESTI (SEST oueut hnctice) # Connaction {COM7)
e —— el

Note

° é M Displaying simple trends (P. 4-4) for details on changing the
waveform display width.

B Displaying waveform data as numerical acceleration data

Click on [Numeric] tab inside the graph display to display the waveform data as
numeric figures.

Click the [Graph] tab to return to the wave form graph display window.

File View Help
PG Time. 2015/03/23 08:47:15
Staws  WOnine Stardby. e T Buitcin 2015/03/23 085300
o Mew
‘Twi B Graph ) Mumeric value [Page 92015/08/02 122881 23 1178 33
£ torr e T 7™ e
TR o A B ] o1 0 os 0
8 oo 1 oo msoson o7 ons o2
ST 2 seynaoen sz ous 025
) Sl Vake (PV) 3 215/03/02 12:23:01.030 025 025 0375
© Syt fecel. (1) 5 nshai m2son00 025 025 0s
@ Cake. Accel. s 2015/03/02 12:23:01.050 0.375 o 0625
@ Cak. A Acce. s misoynaoio 02 o osxs
1) Cale. Inclination Accel. 7 2015/03/02 12:23:01.070 0 025 0.5
© Setp s wisosbz 220106 25 w125 05
g Vaveform. s 2015/03/02 12:23:01.090 s 025 05
! 10 21500302 12:23:01.100 0.375 025 s
'8 Res. Cond. u 201500302 12:23:01.110 2375 o 062
@ SV Record Display. 2 2015/03/02 12:23:01.120 025 0 0.625
. B 150302 22301130 o 0125 0s
1w naoLie o o 0
3 sy paoLise o128 o o
1% 2015/03/02 12:23:01. 160 0.375 0.125 0.5
v s masoLm 2125 o os .
B Reocod [ WeeOss [M ook | svRecDiply | Fiesove | Foroed Rec | ekte | Retun

B Confirming or changing recording conditions

In the List of Waveforms screen, press [F1] Recording Conditions to switch to a
screen displaying the settings fields for recording conditions.

When the earthquake sensor is in Measurement mode, a message will be dis-
played asking if you want to switch to Standby mode.

4-20
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@ Switch to Standby?

[ves]:Change Screenwith Mode transitian

[Ma]:Change Screen with Non Mode transition
[Cancel]:Cluit

M el]x o [0 o |

¢ To change waveform recording conditions, click [Yes] and switch to Standby
mode.

* To confirm current waveform recording conditions, click [No] to change
screens without switching to Standby mode .

® To cancel, click [Cancel]. The system will return to the Top screen.

o Theeshold Syath. heoal. 8 e
ok AG Actal, Threshold M-¥.E.¥.
Cake.

You can set the following fields at the Waveform Recording Conditions screen.

Refer to the Earthquake Sensor SES70 user manual (for design) for details on
the characteristics of each method.
(1) Rec.Trigger:

You can select one of the following Rec.Trigger.

* Max. Wave (+Trigger Updating)

* Max. Wave (-Trigger Updating)

* Threshold

(2) Max. Wave (+Trigger Updating):

When you select Max. Wave (+Trigger Updating) as the Rec.Trigger in (1),
select the maximum value object from among the following.

* SI value
* Synth. Accel.
*M.VEV

(3) Max. Wave (—Trigger Updating):

When you select Max. Wave (-Trigger Updating) as the Rec.Trigger in (1),
select the maximum value object from among the following.

* SI value
* Synth. Accel.
* M.VEV
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(4) Threshold

When you select Threshold value format as the Rec.Trigger in (1), select
the maximum value object from among the following.

* SI value
* Synth. Accel.
* M.VEV

(5) Threshold value

When you select Threshold value format as the Rec.Trigger in (1), set the
threshold value for each threshold value object.

Settings fields and default values

Item name Setting Default value | Setincrements
Rec.Trigger Select from Max. Wave (+Trigger Updating) Threshold format —
Max. Wave (—Trigger Updating) Threshold format

Max. Wave (+Trigger Updating) | Select from SI, Synth. Accel., or M.V.E.V. Slvalue —
object

Max. Wave (—Trigger Updating) | Select from SI, Synth. Accel., or M.V.E.V. Slvalue —
object

Threshold object Select from S, Synth. Accel., or M\V.E.V. Slvalue —
Threshold SI 1 to 300 kine 1 kine 1 kine
Threshold - Synth. Accel. 5 to 4000 Gal 5 Gal 1 Gal
Threshold - M\V.EV 1.0t0 7.9 1.0 0.1

m Handling Precautions

* The default values for SES70 waveform recording conditions have changed
compared to the SES60. The changed content is as follows.

Default settings for waveform recording conditions (comparison with pre-

vious model)

Rec.Trigger Threshold Max. Wave
(+Trigger Updating)

Max. Wave (+Trigger Updating) object Slvalue Slvalue
Max. Wave (-Trigger Updating) object Sl value - (no function)
Threshold object Slvalue Slvalue
Threshold Sl 1 kine 30 kine
Threshold - Synth. Accel. 5 Gal 300 Gal
Threshold - M.V.EV 1.0 53

*The purpose of changing the default value in the SES70 to the Threshold value was
to record the most recent earthquakes and vibrations as well as to confirm stabil-
ity for the setup location. Change this field to Max. Wave if you want to record the
largest past vibrations.

* Changing the recording conditions will require the deletion of all recording
conditions. If an active waveform exists, the following screen will be dis-
played when you press [F7] Write Settings.

¢ Delete the waveform prior to changing the waveform recording conditions.
4-22
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* Also, make sure to save any required waveforms prior to deleting them.

Cannotwrite the wavetorm memory setting because there is avalid wavetorm,

Delete the wavetorm before changing the setting.

@® How to change waveform recording conditions

@® How to input settings

To change waveform recording conditions, align the cursor (blue inverted char-
acter) with the content in the field you want to change in the waveform record-
ing conditions window and double-click.

There are two ways to input values as indicated below. The input method varies
with each method.

(1) Select
(2) Numeric input

After inputting all waveform recording conditions, press the [F7] Write Settings
button. The changed values are written to the earthquake sensor memory. After
writing settings to the memory, those values are read and monitored so you can
confirm that the correct values have been written.

Make sure to write the settings to the memory. If you do not perform this mem-
ory write, the waveform recording conditions will revert to the previous values
once you reset the earthquake sensor or go to the Initialize screen.

(1) Double-click on a selection method, select the field you want to set from
the pull-down, and then press the [Enter] key.

Ilem |Value/Status Unit
Rec. Trigger Threshold

Max. Wave (+ Trigger Updating) Wax. Wave (+ Trigser Undaling)
Max. Vave (- Trigesr Updating) il dudativ
Threshold Object

Threshald 81

Threshold Synth. Accel.
Threshold M.Y.E.Y.

kine
Gal

N
(2) Numeric input method

Click on the desired field line, input the desired values in half-width char-
acters, and then press the [Enter] key. For reference, you can align the cur-
sor with the value field to display the applicable value range at the bottom
left of the screen. The field column becomes red to indicate an error if a
value exceeding the applicable range is input. Make sure to input an ap-
propriate value.

Illen Value/Status Unit

Rec. Trigger Threshold
Max. Pave (+ Trigger Updating) |8I Value
Max. Wave (- Trigger Updating) |SI Value

Threshold Object 81 Value

Threshold SI ]
Threshold Synth. Accel . 5 Gal
Threshold M.¥.E.Y. 1.&

N\
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Bl Making graphs easier to view

You can change the number of axis lines displayed if the graph displays of the X,
Y, Z axes overlap making the display difficult to view.

While displaying a graph, press [F3] Displayor right-click on the graph to display
a list of display change options.

The operation method is the same as for Simple Trends so see (? H Displaying
simple trends (P. 4-4) for details.

B About SV Record Display (Full Setup only) [SES70 only]

4-24

During waveform recording, you can display the SV value (speed response value
for each fixed cycle) calculated during the SI value calculation process.

Press [F4] SV Record Display. The following screen is displayed.

The SV value (SV1 to SV7) is displayed for the seven fixed cycles of each re-
corded wave. The error flags for each waveform recording are also displayed.

PG Time  2015/03/23 186200

Stats [ Onine Stendby FE R i ibed Built-n  2015/03/23 085754

Value/Status
/18 16:35:12

! Satup
= g Waveform
- Wavstorm List

a CGond

svi 1.6 kine

sv2 1.3 kine
- Maral sv3 B 1.3 kine
sva 118 kine

Y5 1.3 kine
SVE 1.3 kine
lsv1 1143 kine

m el @ |m [z = |= = (B roum
SES70 (SES 70 output function) # Connection (COM7)

If ST Value 2 (24 fixed cycles, 16-direction projection) is selected for the SI calcu-
lation, you can select which 7 fixed cycles are displayed from among the 24 fixed
cycles.

At the SV Record Display screen, press [F1] Select SV Record Object.

If in Measurement mode when switching to the Select SV Record Object screen,
the following screen is displayed and you must return to Standby mode.

Switch to Standhby?

[ves]:Change Screen with Mode transition
[Mao]:Change Screen with Non Mode transition
[Cancel]:Cluit

Cance|
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Here, the following screen is displayed if SI Value 1 is selected for the SI calcula-
tion and you cannot change the SV record object.

Slwalue 1 is selected as the current Slvalue (FV).
This function is walid only if 51 2 is selected.

If in Standby mode and SI Value 2 is selected for the SI calculation, pressing
[F1] Select SV Record Object button will display the following screen and you
can select the fixed cycles for the SV record object.

SI2 value SV

There are 24 Vs for SIvalue, 2 for each fixed cycle.
Select the desired 7 SVs to be recorded.

T ascending order osf‘;?a selected fixed cycles (T), the waveform information will be
o SVT.

recorded in SV1 &
Ve (=] 7] D SV (T=0586~)
] : SV (T=0115+) [ B SV (T=08161)
[ sV (T=0.132+) E SV (T=0206-)
[ & SV (T=0152+) 1 G SV (T=0816+)
[[] & SV (T=0.175) [¥] B SV (T=0938-)
[F] & 8V (T=0201-) [ E SV (T=1078)
[] & SV (T=0281-) (O] & SV (T=1241-)
[[] & 8V (T=0266-) 7] K SV (T=1428-)
[] & SV (T=0306) [0] L SV (T=18642)
[] & SV (T=0362+) M SV (T=1868-)
& SV (T=0406) [C] N Sv(T=2173)
[] B SV (T=0466) [¥] B SV (T=2500)

* T is a fixed cycle (s).
* If this operation i executed, the mode will change to initialization mode.

v x  |[% gmea

At this screen, select the 7 fixed cycles that you want to record from among the
24 fixed cycles for SI Value 2.

The wave form information is recorded for the selected fixed cycles in order of
smallest first (SV1, SV2, SV3... SV7).

B Saving waveform data to PC

You can save all enabled waveforms displayed in the List of Waveforms to the
PC. (You cannot select and save desired waveforms.)

When you save waveform data, the settings change file is also saved. (Be careful
as the waveform data is not saved if you save the settings change file from the
Setup screen.)

[Information saved when the waveform record is saved]

(1) Waveform data: Maximum 11 waves (10 auto-record waveforms + 1 forced
record waveform)

(2) Earthquake sensor settings file
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How to save
(1) Press [F5] Save File.

>> A file name input dialog box is displayed.

o B Emp

Num File Size  Date/Time

001 sample_001.500SE7 1195 KB 2018/01/21 17:6430
002 sample_p2 001 S00SE7 1185 KB 2014/12/18 11:47:28
003 sample p2 SO0SE? 1133 KB 2014/00/26 16:5832

Fileniame: | % gamel

“ After this operation is executed, all waveform files and the settings file will be saved.

(2) Input the file name and click [Save] or press the [Enter] key.

>> The file is saved. The save file function is available only on online mode
when the earthquake sensor is connected to this Loader.

The time required for file save will vary depending on the number of waveforms
and communications speed. The approximate times are as follows.

* Loader communication (communications speed 115200 bps, all 11 waves):
Approx. 6 min

® RS-485 communication (communications speed 38400 bps, all 11 waves):
Approx. 14 min

Note

* When you save waveform file data, the settings file data is saved
automatically.

Bl About the file name of the saved file

[File save location]

The default (standard folder) is as follows. To change the save location, click
“Change Folder” to set the save location. Click [Standard Folder] button to
reselect the standard folder after changing the folder.

@ Default (standard folder)
C:\Users\username\Documents\slp\SlpSe7\data
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[Filename]

The file name is as shown below. Other than the character string specified
by the user, the file name is determined automatically.

@ Filename: name_VVV_*00.%**

Name: filename specified by the user
VVV: Version number (for each name)
*00:  Data type
W00 to 11 > Waveform data (number is the same as the page
number)
S00> settings file
X Extension
CSV > waveform data
SE7 > Loader-only file

Note: If a file with the same name exists, the file is not overwritten. Instead,
it is saved as a new file with a sequential version number.

[File format]

(1) Waveform data: Saved as CSV file. The waveform header information
and the acceleration for the X, Y, and Z axes are saved.
This information can be viewed using Excel, etc.

(2) Settings file:  File is saved with the “SE7” extension (“***.SE7”). You
can use the Loader (offline) to view the data. This con-
tent is not published.

B Manually recording waveform data

This function enables the manual recording of waveform data. Use when you
want to confirm the status of acceleration measurement.

Press [F6] Force Record to begin the manual recording (forced record) of the
waveform. This waveform is recorded for a period of 360 s after the start record
command is issued to the force record buffer.

(1) Press [F6] Force Record

>> When the earthquake sensor is in Standby mode, a confirmation screen

is displayed.

— Intelligent Earthguake Sensor l £% .'

|@ Start Forced Yavetorm Recording.

o Cancel |
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The following screen is displayed if the earthquake sensor is in Measurement
mode. Click [Yes] to switch to Standby mode. Then the above confirmation
screen is displayed.

@ Change to standby mode?

[¥es]: Processing will be executed after the mode is changed to standby mode

[Me]: Processing will be aborted without changing the mode

x |

(2) Click [OK].

>> The forced recording of the waveform is started.

Note

* You can confirm the status of the waveform during and after recording in
display area F*.

Recording waveform

Fle View Hep I

Staws  [WOnline Stanchy 10 Fecording Waveform RS~485 Yite Disabled WAL g:::;zzgz ik
[Mme | [Wave Record Page |Trieser Time S Accel. N.V.E-V. Alarn Liquef .| J.¥.0-
L Menitar Paze 0
Ei'}ﬁ‘ﬂ’;%m Page | 2015/03/19 16:43:58 1.3 68.3 2.8
@ Latch Paze 2 2015/03/18 17:18:36 1.1 44.1 2.7
g Trend Paze 5 2015/03/20 08:32:12 1.1 85.3 2.8
© Sl Vake (PY) Page 4 2015/03/23 08:12:05 1.3 76.1 2.8
€L Synth. Accel. (FY)
@ oot hooet Paze 5 Dissble
1 Gake. A0 Accel Paze 6 2015/02/27 18:02:33 1.1 51.8 2.7
1 Cak. Ielnation ccel. | [Page 1 2015/02/27 14:88:23 1.3 65.0 2.8
Paze 8 2015/02/27 15:10:52 2.4 119.8 3.4
Paze 8 2015/03/02 12:28:81 2.3 117.8 3.3
© Ree Paze 10 2015/03/02 17:20:45 1.0 40. 2.7
€1 5 Record Display Forced Rec. Pase Dissble
L Marual
L Disenosis
Fec Cond B WeveDsp | Dipky  |B SVRechisply [ Fiesee [F FocedRec |@ Dokt [F]  Retm
SE570 (SES70 output furction) » Connection (COM7)

Recording waveform

Fle View Hep l

PO Time  2015/03/23 084831
Status [ Oniine Standhy FIS~485 Ytite Disabled PP ULt
[ Ter Wave Record Page |Trlgger Tine 81 hccel . HAV.E.V. [Alarn Liauef [J.¥..
. Monitar Page 0
Eig’smm Page | 2015/03/19 16:43:58 1.3 88.3 2.8
O Latch Page 2 2015/03/19 17:18:28 1.1 a4.1 2.7
- ligh Trend Page 3 2015/03/20 08:32:12 1.0 B5.3 2.8
© & Vake (PV) Page 4 2015/03/23 08:12:05 1.3 76.1 2.8
Sl
€ Cale, A Accel. Page 6 2015/02/27 13:02:33 1.1 5.8 2.7
© Cale. nclination Accel. | [Page 7 2015/02/27 14:96:28 1.3 850 2.9
C Setp Page 8 2015/02/27 15:10:52 2.4 119.6 3.4
E‘é" 5 Page 9 2015/03/02 12:28:81 2.3 117.8 3.3
2 Rec. Cond. Page 10 2015/03/02 17:20:43 1.1 40.9 2.7
. € 5 Record Display Forced Rec. Paze |Disable
Maral
€L Disenosis |
il

* G 3-1 Basic Operations (P. 3-2) for information on the display area.
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B Deleting waveform data

(1) Press [F7] Delete Waveform to delete all waveforms.

>> When the earthquake sensor is in Standby mode, a confirmation screen
is displayed.

@ Delete all waveform records.

l Cancel |

The following screen is displayed if the earthquake sensor is in Measurement
mode. Click [Yes] to switch to Standby mode. Then the above confirmation
screen is displayed.

Change to standby moda?

[Yes]: Processing will be executed after the mode is changed to standby mode
[Na]: Processing will be aborted without changing the mode

(2) Click [OK].

>> All waveform data is deleted.

B About waveform data content

Waveform data saved via this Loader is saved as a CSV file.

The file contains waveform header information and the acceleration for the X, Y,

and Z axes. You can use Microsoft Excel or other spreadsheet application to view
the file.
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4 - 4 Manual output [F5]

You can select [F5] Manual Output in the main menu to force the output of selected values for the earthquake
sensor's output ports (AO, DO, Control).

With the earthquake sensor in Standby mode, press [F5] Manual Output in the main menu or select Manual
Output in the displayed menu tree to display the Manual Output/Setup screen.

When the earthquake sensor is in Measurement mode, a message will be displayed asking if you want to switch
to Standby mode.

|@ Switch to Standhy?

[ves]:.Change Screen with Mode transitian

[Ma]:Change Screen with Mon Mode transition
[Cancel]:Cuit

Cancel

* To conduct manual output, click [Yes] and switch to Standby mode.

* To view the Manual Output screen, click [No] to change screens without
switching to Standby mode.

* To cancel, click [Cancel]. The system will return to the Top screen.

@® Manual output screen

You can use this function to conduct an external device test.

PGTime  2015/08/28 160735

Stats  [Onine Standby Lt A B Built-n  2015/03/23 021328
Tten Valus/Status Uit [~
(Operat ing Hode (unchangeable) Standby.
Select Auto/Manual Auto
S1 Value (PY) 0.0 Kine
Synth. Accel. (PY) a4 Gal
0.0
0FF
0. OFF
J.N.0.2 (B0 OFF L
J.V.0.3 (P¥) OFF
A01 Qutput 0.0 %
402 Qutput 0.0 x
Control Output 1 OFF
Control Output 2 oFF
Gontrol Cutput 3 0FF
001 Qutput Blink
002 Outeut 0FF L
J008 ut put OFF o
IF1] |2 |m@ = [= i | Wovt Contimation| B Retum

SES70 (SES70 output function) # Connection (COM7)
e

Double-click on “Manual Output Selection” in the Manual Output screen.
“Auto,” “PV Manual Output,” “AO/DO Manual Output” are displayed in the pull-
down menu. Select the item you want to change and press [ENTER].

After completing all input, press the [F7] Confirm Output button. The changed
values are written to the earthquake sensor memory. After writing settings to the
memory, those values are read and monitored so you can confirm that the cor-
rect values have been written.

Select “Auto” to disable manual output.
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@® How to conduct manual output
The two following ways allow you to conduct manual output
(1) PV Manual Output:
The following PV are output manually.
- SI(PV) - M.VEV. (PV)
* Synth. Accel. (PV) * Liquef. (PV)

The PV are output manually, so the corresponding AO and DO output is
also conducted. (For example, the control output is set to ON/OFF based on
the J.V.D. threshold.)

PV Manual Output

Item name Setting Default value |Setincrements
SI(PV) 0 to 300 kine * 1 kine
Synth. Accel. (PV) 0 to 4000 Gal * 1 Gal
M.V.EV (PV) 0to 7.9 * 0.1
Liquef. (PV) Enable/Disable * —

*The default value is the output value based on the setting for “PV Manual Output” set
under Manual Output Selection.

(2) AO/DO Manual Output:
The following AO/DO/Control Output are output manually.

* AO1 manual output * DO1 Output
* AO2 manual output * DO2 Output
* Control output 1,2, 3 * DO3 Output
* DO4 Output
AO Manual output

Item name Setting Default value |Setincrements
AO1 Manual output —10.0to 110.0% * 0.1%
AO2 Manual output —10.0 to 110.0% * 0.1%

*The default value is the output value based on the setting for "AO/DO Manual Output”
set under Manual Output Selection.

Control Output

Iltem name Setting Default value |Setincrements
Control Output 1 ON/OFF * _
Control Output 2 ON/OFF * —
Control Output 3 ON/OFF * _

"

*The default value is the output value based on the setting for "AO/DO Manual Output
set under Manual Output Selection.

DO Output
Item name Setting Default value | Setincrements
DO1 Output ON/OFF/Flash *1 —
DO2 Output ON/OFF 1 —
DO3 Output ON/OFF 1 —
DO4 Output ON/OFF/Flash *2 * —

*1.The default value is the output value based on the setting for "AO/DO Manual
Output” set under Manual Output Selection.

*2.The terminal status is Slow ON/OFF
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* Set the internal judgment for DO output. As such, if negative logic is selected
for DO1 Output, DO2 Output, or DO3 Output, the set values may differ from
the status of the actual DO terminal. The following indicates the correlation
between the set values and the actual terminal status.

. SES70 terminal status
Item Manual output Setting — - - -

Positive logic Negative logic
Minor failure OFF OFF ON
ON ON OFF

Blinking Slow ON/OFF Slow ON/OFF
Serious failure OFF OFF ON
ON ON OFF
Noise protect OFF OFF ON
ON ON OFF

@® How to input settings

(1) Double-click on a selection method, select the field you want to set from
the pull-down, and then press the [Enter] key.

l]lan Value/Status Unit

Operating Mode (unchangeable) Standby

Select Auto/lanual 40/D0 Manual

|8t value (PY) 0.0 kine
|Synth. Accel. (PV)
WV.EV. (PY)
Liguef. (PV)
J-¥.D.1 (PY)
J.¥.0.2 (PV)
J.¥.D.3 (PV)

AO1 Output

AD2 Output

Control Output 1
Control Output 2
Control Output 3
DO1 Output

D02 Qutput

D03 Qutput

(2) Numeric input method

Click on the desired field line, input the desired values in half-width char-
acters, and then press the [Enter] key. For reference, you can align the cur-
sor with the value field to display the applicable value range at the bottom
left of the screen. The field column becomes red to indicate an error if a
value exceeding the applicable range is input. Make sure to input an ap-
propriate value.

PO Time  0IS/08/23 01319

FiS- 456 Wit Disabled Buit-n  2018/03/28 031906

Tten Value/Status

Operating Hode Standby

Pickup Operalion Dl agnosing

Alarm OFF

Calc. Accel. before Mg 7 hxis: -11.8 ¥ Axis: Gal ¥ hxis:
Ic. Accel. after | 7 Mxist 117 ¥ axist .0 Gal ¥ Wxist

Ctri. Accel. before Bias I Axis: 2.3 Y Axis: Gal ¥ Axis:

Gtri. Accel. after Bias 7 axisz -11.4 ¥ axis: Gal ¥ Axis:

Auto Bias Value Mis: 0.0 ¥ hxist -0 Gal X Axist

& I |B verose  [@ s |E B @ woesetees [ Feun
‘SES0 (SESTD output hunetion) # Connection (COM7)
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This function allows you to run a self-diagnosis for the accelerator pickup and perform a zero-adjust on the

accelerator.

With the earthquake sensor in Standby mode, press [F6] Diagnosis in the main menu or select [Setup] > [Setup]

in the displayed menu tree to display the Setup screen.

When the earthquake sensor is in Measurement mode, a message will be displayed asking if you want to switch

to Standby mode.

@ Switch to Standby?

[res]:Change Screen with Mode transition

[No]:.Change Screen with Non Mode transition

[Cancel]:Quit

Fedx ®© |© o |

¢ To run the diagnosis

, click [Yes] and switch to Standby mode.

¢ To view Diagnosis screen details, click [No] to change the screen without
switching to Standby mode.

¢ To cancel, click [Cancel]. The system will return to the Top screen.

. o PC Time 2015/03/23 0R11:36
Swws [ Online Standby RiS-485 Write Dissbled A Lichinfic o
T Iten Value/Stalus
a il Operal ing Mode [$tandby
@ Pickup Operation ---
L@ Latch Alarm . |OFF
I Tend Calc. Accel. before Bias |2 axis:  -12.0 Gal ¥ Axis: 18.3 Gal X Axis:  10.6 Gal
i 85""-‘-(”‘”‘” Calc. Accel. after Bias 7 Axis: -12.0 Gal Y Axis: 18.3 Gal X Axis:  10.B Gal
- g Gtrl. Accal. before Bias |2 Axis:  -12.0 Gal ¥ Axis:  18.4 Gal X Axis:  10.3 Gal
|2 Oako. AC Accel. Gtrl. Accel. after Bias ZAxis: -12.1 Gal ¥ Axis: 18.4 Gal X Axis:  10.5 Gal
éec*.nmmm1 Auto Bias Value |z axist 0.0 Gal YAxist 0.0 Gal XAxist 0.0 Gal
Gatip [ Alar OFF
I Vavetorm {
P8 Woretorm Lit Accel. Value Alarn |oFF
|- Rec. Gond Incli. Accel. Alara oFF
~(C1 SV Recard Displsy
© Marus!
© T
SES70 (SEST0 oot unction) # Connection (COM?)
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B Pickup diagnosis
(1) Press [F3] Start Diagnosis to run the earthquake sensor pickup diagnosis.

>> A confirmation screen is displayed.

@ Start Self-diagnosis

The following screen is displayed if the earthquake sensor is in
Measurement mode. Click [Yes].

Change to standby mode?

[Yes): Processing will be executed after the mode is changed to standby mode
[No]: Processing will be aborted without changing the mode

M=dx » |

(2) Click [OK].

>> During diagnosis, the pickup operating status switches to “Running
Diagnosis” Once finished, “Diagnosis Complete” is displayed and the
diagnosis results are shown on the screen.

Running Diagnosis screen

RS- 185 Writn Disabled

Ites Value/Status

Operating Vode

Pickup Operation

Alarm |

Calc. Accel. before Bias 1 K j Gal X Axist

Calc. Accel. after Bias : g Gal X Axis:
.6 Gal X Axis:

C I Axis » t Gal X Axist

Z Axis: X 5 Gal X Axis:

|OFF

[ Wite sentines Ratum

SES70 (SEST0 autput function) # Connection (COM;
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Diagnosis Complete screen (for normal complete)

Is-;mu-h

FC Time  2015/08/23 181854
Built-n 2015/08/23 191948

Iten Value/Status
|Operating Node Standy
Pickup Operation [Finished
Alarm OFF

Gal X Axis:
Calc. Accel. after Bias I Axis B H Gal X Axis:
Ctrl. Accel. before Bias Ia of 3 Gal X Axist
Cirl. Accel. after Bias 14 Gal X Axis:

Auto Bias Value T Axis: .0 Gal Y Axis: Gal X Axis:

Diagnosis Complete screen (when an error is discovered)

If an error is discovered, “Yes” is displayed under “Pickup Errors”

RS- 185 White Disabled

Iten Value/Status
Gperating Hode Standby
Pickup Operstion [Finished
alarm Serious
Calc. Accel. before Bias 2 Axist . : Gal K Axist
Calc. Accel. after Blas 12 Mxis: 5 Gal X Axis:
. before Bias 2 wis: X 2 Gal X Axis:
.  Axist X t Gal X Axist
7 Auis: . H Gal X Axis:

Diagnosis Alara
dccel. Value Alarn
Incii. Accel. Alarm

E] Handling Precautions

¢ After starting the diagnosis, error flag noise is produced and “Noise Protect
is displayed in display area K* at the bottom of the screen. This is not an
error. This operation is forcefully mimicking acceleration pickup during the
diagnosis. This will stop approximately 100 s after the start of the diagnosis.
* 3-1 Basic Operations (P3-2) for information on the display area.

"
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B Zero-Adjust (Full Setup)

(1) Press [F4] Zero-Adjust to automatically correct the acceleration to zero.

>> A confirmation screen is displayed.

.-'_ . H-.
&8 Intelligent Earthquake Sensor l 28 J

|@ Set acceleration bias for adjusting to zero

Cancel

(2) Click [OK].

After adjustment, the acceleration (adjusted) field value is close to 0 to in-
dicate that the value has been adjusted.

(3) Press [F7] Write Settings to write the adjusted value to the earthquake
sensor. The changed values are written to the earthquake sensor memory.
After writing settings to the memory, those values are read and monitored
so you can confirm that the correct values have been written.

Make sure to write the settings to the memory. If you do not perform this
memory write, the zero-adjust value will revert to the previous values once
you reset the earthquake sensor or go to the Initialize screen.

[z] Handling Precautions

* In some cases, “Noise Protect”is displayed at the bottom of the screen in
display area G during the adjustment. This is not an error. This operation
is forcefully adjusting the acceleration to zero. The Noise Protect status
will disappear approximately 100 s after the start of the adjustment.
However, as the AC acceleration is not changed via the zero-adjust, this
has no impact on the Synth. AC Accel,, SI, M.V.E.V.,, or Liquef. Judg. values
used as controls. As such, normally this is not used. Zero-adjust cannot be
conducted once the acceleration adjustment value calculation reaches
+150 Gal.
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4 -6 ModeChange[F7]

Press [F7] Mode Change in the main menu or select Mode Change in the displayed menu tree to display the

Mode Change screen.

Here, you change the earthquake sensor mode.

1: Initialize mode
2: Measurement mode
3: Standby mode

4: Maintenance mode

[ M.()ﬂ;(.:h;nge

1 Initialize

@ 2 Measure

() 3 Standby

) & Maintenance

Cancel

|TU change the mode to measurement mode, select initialization mode.

Check the radio button of the desired mode and then click [OK].
>> The mode is changed and the dialog box will close.
Select Initialized mode when you want to change to Measurement mode.

Note: If a serious failure has occurred, the system will go to Standby mode auto-
matically and will not go into Measurement mode.

E] Handling Precautions

@® Maintenance mode

* Please note that the SES60 may produce unstable analog output in
Initialize mode.

Maintenance mode runs the earthquake sensor relay output and AO/DO output
in a predetermined sequence to confirm the stability of the earthquake sensor
and system.

The Maintenance mode sequence runs sequentially in phases 1 through 3.
Screen operation is required to proceed to the next phase.

[Switching to Maintenance mode]

With the earthquake sensor in Measurement mode, press [F7] Mode Change in
the menu screen. Select Maintenance from the Mode Change screen and click
[OK]. A screen confirming you want to switch to Maintenance mode is dis-
played. Click [Yes].

This initiates Maintenance mode phase 1.
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[Maintenance mode: Phase 1]

In progress: You cannot operate the Loader while running Maintenance mode
phase 1.

Mainenance/Phese op

Phage: Phaze1

Frocessing status: Funning

Finished: After phase 1 ends, you can select whether to run phase 2 or to exit
Maintenance mode.

Click [Next] to run phase 2.

Click [Close] to exit Maintenance mode. Exiting will send the earthquake sensor
into Initialize mode.

Phage: Phaze1

Processing status:  Execution completed

[Maintenance mode: Phase 2]
Similar to phase 1, after phase 2 finishes you can select whether to continue onto
phase 3 or to exit Maintenance mode.

Select whether you want to continue onto phase 3 or to exit.

[Maintenance mode: Phase 3]

Once phase 3 is finished, the only selection option is the [Close] button. Click
[Close] to exist Maintenance mode. Exiting will send the earthquake sensor into
Initialize mode.

MaitenancePrase o

Phase: Phazed

Processing status:  Execution completed




Chapter 5. TROUBLESHOOTING

B List of Error Messages

In the event of a key operation error, an error message is displayed in a message

box or in display area K*. The methods for responding to these messages are

shown below.

03 3-1 Basic Operations (P. 3-2) for information on the display area.

Message

Response

No name specified for the save file.

Input a filename.

Waveform updated during read. Process canceled.

The record waveform process was executed during the read
waveform process and the specified waveform was updated.

Confirm the waveform information from the List of Waveforms.

Waveform disabled during read. Process canceled.

The record waveform process was executed during the read
waveform process and the specified waveform was disabled.

Confirm the waveform information from the List of Waveforms.

Mode is not Measurement mode.
Waveform auto-record not allowed.
Exit?

The earthquake sensor is attempting to exit the Loader while
in a mode other than Measurement mode. Normally, switch to
Measurement mode, the mode in which waveform auto-record
is executed, and then exit.

Serious failure
Noise protect
Minor failure

Typical errors produced by the earthquake sensor.

Confirm error details and refer to the user manual for
troubleshooting.

File cannot be opened. Invalid changes were made or
the file is damaged.

There is a possibility the settings file is damaged or the file is
not correct. Reread the file or

specify the correct file.

USE loader cable not inserted.

Connect the USB loader cable to the PC.

Connection with earthquake sensor failed. The fol-
lowing are possible causes.

* Error in communication transmission settings
* Earthquake sensor not connected
Startup offline

Communications not possible. Confirm that the communica-
tions line (cable or terminal) is connected to the earthquake
sensor.

Also confirm communications settings.

Error in settings (row number)

Change the settings and redo the write settings
operation.

Error in set field. Confirm settings details.

Communications error occurred during connection
with the earthquake sensor.

Exiting program.

Restart the program and confirm communications.

Contact us if this error occurs again.

Acceleration adjustment value is £150 Gal or higher.
Zero-adjust not allowed.

Confirm settings details.

The earthquake sensor is tiled too far and zero-adjust is not pos-
sible. Redo device setup.

Cannot write during Loader communication.
Remove the USB loader cable from the SES and retry.

USB loader cable inserted during RS-485 communication with
earthquake sensor. Remove the USB loader cable from the SES
and retry.

Cannot open help file. Confirm that Acrobat Reader is
installed or that the help file exists.

Confirm that Acrobat Reader is installed. Confirm that the help
file exists.

Files required for Loader operation not found.

Reinstall the Loader.

Reinstall the Loader.

USB loader cable COM port number not selected.

Select a USE loader cable COM port number from the
Communications Settings screen.
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Message

Response

485 communication COM port number not selected.

Select a 485 communication COM port number from the
Communications Settings screen.

Active waveform exists. Cannot write the waveform
recording settings.

Delete the waveform prior to changing the waveform
recording settings.

Delete the waveform prior to changing the waveform recording
condition.

Cannot start diagnosis because diagnosis is running.

Conduct operation after the diagnosis is finished.

Conduct operation after changing to Measurement
or Standby mode.

Conduct operation after changing to Measurement mode or
Standby mode.

Change to Standby mode.

Currently in mode other than Standby mode. Change to
Standby mode at the Change Mode screen.

Communications timeout error occurred during con-
nection with the earthquake sensor.

Exiting program.

Confirm that the earthquake sensor power is ON and that
the loader cable or RS-485 communications line is connected

properly.

Target waveform record file does not exist.

Specified waveform record file does not exist. Specify the cor-
rect waveform file.

System changed to mode other than Maintenance
mode. Canceling operation and returning to main
menu.

The earthquake sensor mode was changed while in
Maintenance mode. Reset the system to Maintenance mode
from the Change Mode screen.

No data changes input. Exit settings without making
changes?

Execute the Write Settings function to apply data changes.

No data changes will be input if you exit now? Exit?

Execute the Write Settings function to apply data changes.

After the zero-adjust, write the adjusted values to the earth-
quake sensor before exiting.

Still in Manual Output. Measurement and calculation
results will not be reflected in PV, output, etc. Exit this
window?

PV, output, etc. are still in Manual Output. To set to normal mea-
surement and calculation status, select Auto Output or switch
to Measurement mode.

Connection with earthquake sensor failed. Model
number of the connected earthquake sensor not
compatible.

Startup offline

The connected earthquake sensor is a model other than SES70/
SES60. Connect an SES70 or SES60.

Cannot switch to Measurement mode. Confirm the
status of the SES.

A serious failure occurred in Initialize mode when changing
modes.

Confirm the status of the earthquake sensor.

Cannot open or read waveform file of specified page.
Exiting.

File is damaged. Specify the correct file.

Mode change failed.

Retry operation.

Retry the mode change.

Phase change failed.

Retry operation.

Retry running Maintenance mode.

Model other than SES70/60.

Cannot open file.

The specified file is for a model other than SES70/SES60. Specify
a file for SES70 or SES60.

No data changes input. Changing display will revert
data to figures prior to changes.

Change display without writing data?

Execute the Write Settings function to apply data changes.

After the zero-adjust, write the adjusted values to the earth-
quake sensor before exiting.

Invalid page. Cannot display waveform.

Specify a valid page.

Incorrect mode. Cannot continue write operation.

Check the operating mode and retry.

Check the operating mode and retry.
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B Troubleshooting confirmed errors

G 4-1 Monitor [F1] (P. 4-1) to check the error status. Use the following pro-
cedures if “Yes” is indicated in the column.

Chapter 5.  TROUBLESHOOTING

General error information

Description

Response

Memory error (Serious
failure)

Memory content or read
error

Confirm error details and then reboot
This may result in the deletion of waveform record data.

Contact us if the problem occurs again.

A/D converter error (Serious
failure)

A/D converting part error

Sensor internal clock error
(Serious failure)

Operational error by the
internal clock

Confirm error details and then reboot

Contact us if the problem occurs again.

Control Output error
(Serious failure)

Control Output circuit error

An error was detected in the control output circuit of the
earthquake sensor.

Replace the earthquake sensor.

Other H/W errors (Serious
failure)

Other H/W errors

Confirm error details and then reboot

Contact us if the problem occurs again.

Pickup diagnosis error
(Serious failure)

Acceleration pickup diagno-
sis output error

Confirm error details and then reboot
Run pickup diagnosis.

Contact us if the problem occurs again.

Acceleration error (Serious
failure)

Acceleration value error

Confirm error details and earthquake sensor setup status
and then reboot.

Contact us if the problem occurs again.

Inclination error (major)
(Serious failure)

Earthquake sensor leveling
error

Same as above

Continuous acceleration
noise error (Serious failure)

Continuous non-vibration
waveform error

Confirm error details and then reboot

Contact us if the problem occurs again.

Battery level error (Minor
failure)

Battery voltage decline
error

Replace with a new battery

Refer to “SES60 Intelligent Earthquake Sensor User's
Manual For System Design (CP-SP-1156E)” for replacement
procedures.

Contact us if the problem occurs again.

Temperature error (Minor
failure)

Earthquake sensor internal
temperature error

Turn device OFF, confirm that the ambient temperature is
normal, and then reboot.

Contact us if the problem occurs again.

Sensor internal clock data
error (minor failure)

Internal clock data error

Confirm that the earthquake sensor internal clock is set to
the correct time.

Contact us if the problem occurs again.

Inclination error (minor)
(Minor failure)

Earthquake sensor leveling
error

Confirm error details and earthquake sensor setup status
and then reboot.

Contact us if the problem occurs again.

Acceleration noise error
(Noise protect)

Non-vibration waveform
detection error

Wait for approximately 100 s.

Contact us if the problem does not disappear or occurs
frequently.
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B Explanation of terminology

A description of the terminology used in user manuals related to the Intelligent
Earthquake Sensor SES70 is provided below.

Terminology

Description

Acceleration

Pickup diagnosis

Acceleration detection element mounted in the device.
Able to detect 3-axis directions X, Y, Z

Sl value

Numeric value correlated to earthquake damage  Unit kine = cm/s
The actual read value and output value are the maximum values for a 10 to 20 second period.
Slvalue 1: 8-direction, 7 fixed cycle Sl calculation

Slvalue 2: 16-direction, 24 fixed cycle Sl calculation

Synth. AC Accel.

Horizontal plane 2-axis or 3-axis vector synthetic AC acceleration unit Gal=cm/s2. The actual read
value and output value are the maximum values for a 10 to 20 second period.

MVEV

Damage measurement value calculated using the Sl value only or using a relative equation based
on the Sl value and the synthetic AC acceleration

Characterization
correction

Uses temperature sensor values to correct the acceleration pickup output temperature characteris-
tics to improve the accuracy of the measured acceleration.

Calculation
acceleration

Acceleration value containing frequency domain required for Sl and M.V.E.V. calculation.
Also used in waveform recording and the synthetic AC acceleration PV.

Control Accel.

Acceleration value cut at a higher frequency domain compared to the Calculation Accel. in order to
reduce background noise for AO, monitoring, etc.

Adjusted Accel.

Acceleration adjusted for bias.

Inclination Accel.

Value representing static acceleration factoring in temperature drift and inclination due to setup
conditions.

AC Accel.

Value representing dynamic acceleration (=adjusted acceleration - inclination acceleration)

JVD.

J.V.D. status initiated when values set for Sl and Synth. Accel. are exceeded and output conditions
are satisfied.

Control Output

When J.V.D. Condition is fulfilled and there is no error status, the control output relay is set to ON.

Liquef. (PV)

Liquef. detect status is enabled when the SI, Synth. Accel., estimate variance, and zero-cross count
Liquef. (PV) conditions are fulfilled.

Liquefaction
Output

When J.V.D. Condition is fulfilled and there is no error status, the Lique. control output DO3 is set to
ON.

Record waveform

There are two functions: auto-record (10 waveforms) and force record (1 waveform).

Error diagnosis

Four types of errors are detected: reset, serious failure, minor failure, and noise detection.

Reset

Reset is conducted in the event of a serious failure, which can impact all functions.

Serious failure

Error status that can impact control output, liquefaction output, and other control functions.

Serious failure output is set to ON and control output is set to OFF.

Minor failure

Error status with no impact on control output but requires confirmation of waveform record and
clock data retention status, clock data errors, and setup conditions.

Minor failure output set to ON.

Noise detection

Noise protect

Status for detection of non-seismic signals that can impact calculation results.

PV values set to 0 or OFF and minor failure flashes.

Maintenance

The output status in Maintenance mode will change depending on the sequence. This makes it pos-
sible to check operations of externally connected instruments.

Sequence

Pickup diagnosis | Physically operates pickups via the diagnosis circuit to detect pickup operation errors.

Auto bias Automatically adjusts the bias value using the Loader.

FSG Acceleration range subject to performance guarantee: 1960 Gal (weighted acceleration standard
+980 Gal) span value.

%FSG 1960 Gal span percentage (+2 %FSG = +39.2 Gal)

FSO Measurable acceleration range: 4000 Gal span value (2000 Gal)

9%FSO 4000 Gal span percentage (+2 %FSO = +80 Gal)
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Bl How to set the SES70 to the same output method as the SES60 (SES60 compat-

ibility function)
You can change the following settings to set the SES70 to perform the same op-
erations as the SES60. (The following is a comparison with default values. Make
the necessary changes if you have changed the default values.)
Item SES70 output SES60 compatible output
Select output function SES70 output SES60 compatible output

J.V.D. OR condition
J.V.D. AND condition

OR condition: None
AND condition: None

OR condition: Sl value
AND condition: None

JV.D. Sl Threshold 300 kine 30 kine
J.V.D. Synth. Accel. Threshold 4000 Gal 300 Gal
J.V.D. M.V.EV. threshold 7.9 5.3
Rec.Trigger Threshold — Max. Wave (+ Trigger Updating)
Max. Wave (+ Trigger Updating) Slvalue Slvalue
object

Max. Wave (- Trigger Updating) Sl value — (no function)
object

Threshold object Slvalue Slvalue
Threshold SI 1 kine 30 kine
Threshold - Synth. Accel. 5 Gal 300 Gal
Threshold - M\V.EV 1.0 5.3
RS-485 communication speed 38400 bps 19200 bps

Minor Failure Outp Choice (DOT)

Positive logic value Status/Minor Failure

Positive logic value Status/Minor Failure
(Functions as Status/Noise/Minor Failure)

Serious Fail. Outp Choice (DO2) Positive logic Positive logic
SIPV low cut 1.0 kine 0.0 kine
Synth. Accel. PV low cut 5.0 Gal 0.0 Gal
M.V.E.V. PV low cut 1.0 0.0
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Printed |Edn.| Revised pages Description
Apr.2015| 1
Mar.2017 | 2 |[4-14, App-2 Tables were changed.

End of the manual| Terms and Conditions were changed (to version No. AA511A-014-09).




Terms and Conditions

We would like to express our appreciation for your purchase and use of Azbil Corporation's products.

You are required to acknowledge and agree upon the following terms and conditions for your purchase of Azbil Corporation's
products (system products, field instruments, control valves, and control products), unless otherwise stated in any separate
document, including, without limitation, estimation sheets, written agreements, catalogs, specifications and instruction manuals.

1. Warranty period and warranty scope
1.1 Warranty period
Azbil Corporation's products shall be warranted for one (1) year from the date of your purchase of the said products
or the delivery of the said products to a place designated by you.
1.2 Warranty scope
In the event that Azbil Corporation's product has any failure attributable to azbil during the aforementioned warranty
period, Azbil Corporation shall, without charge, deliver a replacement for the said product to the place where you
purchased, or repair the said product and deliver it to the aforementioned place.
Notwithstanding the foregoing, any failure falling under one of the following shall not be covered under this
warranty:
(1) Failure caused by your improper use of azbil product
(noncompliance with conditions, environment of use, precautions, etc. set forth in catalogs, specifications,
instruction manuals, etc.);
(2) Failure caused for other reasons than Azbil Corporation's product;
(3) Failure caused by any modification or repair made by any person other than Azbil Corporation or Azbil
Corporation's subcontractors;
(4) Failure caused by your use of Azbil Corporation's product in a manner not conforming to the intended usage
of that product;
(5) Failure that the state-of-the-art at the time of Azbil Corporation's shipment did not allow Azbil Corporation
to predict; or
(6) Failure that arose from any reason not attributable to Azbil Corporation, including, without limitation, acts of
God, disasters, and actions taken by a third party.
Please note that the term “warranty” as used herein refers to equipment-only-warranty, and Azbil Corporation shall
not be liable for any damages, including direct, indirect, special, incidental or consequential damages in connection
with or arising out of Azbil Corporation's products.

2. Ascertainment of suitability
You are required to ascertain the suitability of Azbil Corporation's product in case of your use of the same with your
machinery, equipment, etc. (hereinafter referred to as “Equipment”) on your own responsibility, taking the following
matters into consideration:
(1) Regulations and standards or laws that your Equipment is to comply with.
(2) Examples of application described in any documents provided by Azbil Corporation are for your reference
purpose only, and you are required to check the functions and safety of your Equipment prior to your use.
(3) Measures to be taken to secure the required level of the reliability and safety of your Equipment in your use
Although azbil is constantly making efforts to improve the quality and reliability of Azbil Corporation's
products, there exists a possibility that parts and machinery may break down.
You are required to provide your Equipment with safety design such as fool-proof design, *1 and fail-safe
design*2 (anti-flame propagation design, etc.), whereby preventing any occurrence of physical injuries,
fires, significant damage, and so forth. Furthermore, fault avoidance, *3 fault tolerance,*4 or the like
should be incorporated so that the said Equipment can satisfy the level of reliability and safety required
for your use.

*1. A design that is safe even if the user makes an error.

*2. A design that is safe even if the device fails.

*3. Avoidance of device failure by using highly reliable components, etc.
*4, The use of redundancy.

3. Precautions and restrictions on application

Azbil Corporation's products other than those explicitly specified as applicable (e.g. azbil Limit Switch For Nuclear
Energy) shall not be used in a nuclear energy controlled area (radiation controlled area).
Any Azbil Corporation's products shall not be used for/with medical equipment.
The products are for industrial use. Do not allow general consumers to install or use any Azbil Corporation's product.
However, azbil products can be incorporated into products used by general consumers. If you intend to use a product
for that purpose, please contact one of our sales representatives.
In addition,
you are required to conduct a consultation with our sales representative and understand detail specifications,
cautions for operation, and so forth by reference to catalogs, specifications, instruction manual, etc. in case that you
intend to use azbil product for any purposes specified in (1) through (6) below.
Moreover, you are required to provide your Equipment with fool-proof design, fail-safe design, anti-flame
propagation design, fault avoidance, fault tolerance, and other kinds of protection/safety circuit design on your own
responsibility to ensure reliability and safety, whereby preventing problems caused by failure or nonconformity.

(1) For use under such conditions or in such environments as not stated in technical documents, including

catalogs, specification, and instruction manuals



4,

5.

(2) For use of specific purposes, such as:
* Nuclear energy/radiation related facilities
[For use outside nuclear energy controlled areas] [For use of Azbil Corporation's Limit Switch For
Nuclear Energy]
* Machinery or equipment for space/sea bottom
* Transportation equipment
[Railway, aircraft, vessels, vehicle equipment, etc.]
* Antidisaster/crime-prevention equipment
* Burning appliances
* Electrothermal equipment
*  Amusement facilities
* Facilities/applications associated directly with billing
Supply systems such as electricity/gas/water supply systems, large-scale communication systems, and
traffic/air traffic control systems requiring high reliability
Facilities that are to comply with regulations of governmental/public agencies or specific industries
Machinery or equipment that may affect human lives, human bodies or properties
Other machinery or equipment equivalent to those set forth in items (1) to (5) above which require high
reliability and safety
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Precautions against long-term use
Use of Azbil Corporation's products, including switches, which contain electronic components, over a prolonged
period may degrade insulation or increase contact-resistance and may result in heat generation or any other similar
problem causing such product or switch to develop safety hazards such as smoking, ignition, and electrification.
Although acceleration of the above situation varies depending on the conditions or environment of use of the
products, you are required not to use any Azbil Corporation's products for a period exceeding ten (10) years unless
otherwise stated in specifications or instruction manuals.

Recommendation for renewal
Mechanical components, such as relays and switches, used for Azbil Corporation's products will reach the end of their
life due to wear by repetitious open/close operations.
In addition, electronic components such as electrolytic capacitors will reach the end of their life due to aged
deterioration based on the conditions or environment in which such electronic components are used.
Although acceleration of the above situation varies depending on the conditions or environment of use, the number
of open/close operations of relays, etc. as prescribed in specifications or instruction manuals, or depending on the
design margin of your machine or equipment, you are required to renew any Azbil Corporation's products every 5 to
10 years unless otherwise specified in specifications or instruction manuals.
System products, field instruments (sensors such as pressure/flow/level sensors, regulating valves, etc.) will reach the
end of their life due to aged deterioration of parts.
For those parts that will reach the end of their life due to aged deterioration, recommended replacement cycles are
prescribed. You are required to replace parts based on such recommended replacement cycles.

Other precautions
Prior to your use of Azbil Corporation's products, you are required to understand and comply with specifications (e.g.,
conditions and environment of use), precautions, warnings/cautions/notices as set forth in the technical documents
prepared for individual Azbil Corporation's products, such as catalogs, specifications, and instruction manuals to
ensure the quality, reliability, and safety of those products.

Changes to specifications
Please note that the descriptions contained in any documents provided by azbil are subject to change without notice
for improvement or for any other reason.
For inquires or information on specifications as you may need to check, please contact our branch offices or sales
offices, or your local sales agents.

Discontinuance of the supply of products/parts
Please note that the production of any Azbil Corporation's product may be discontinued without notice.
For repairable products, we will, in principle, undertake repairs for five (5) years after the discontinuance of those
products. In some cases, however, we cannot undertake such repairs for reasons, such as the absence of repair parts.
For system products, field instruments, we may not be able to undertake parts replacement for similar reasons.

Scope of services
Prices of Azbil Corporation's products do not include any charges for services such as engineer dispatch service.
Accordingly, a separate fee will be charged in any of the following cases:
(1) Installation, adjustment, guidance, and attendance at a test run
(2) Maintenance, inspection, adjustment, and repair
(3) Technical guidance and technical education
(4) Special test or special inspection of a product under the conditions specified by you
Please note that we cannot provide any services as set forth above in a nuclear energy controlled area (radiation
controlled area) or at a place where the level of exposure to radiation is equivalent to that in a nuclear energy
controlled area.

AAS-511A-014-09
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